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ABSTRACT 

Ebey’s Prairie, Washington, was once bisected by a broad riparian corridor consisting of 

waterlogged soils, swampy areas, seasonal ponds, and intermittent flows, which helped 

recharge the local aquifer. By the mid-1900s, agriculture drainage tiles, drainage ditches, 

and fill were being installed by landowners to increase tillable acreage. The extent and 

location of these drainage tiles or the effects these tiles have had on surface water and 

subsequently on aquifer recharge in the area remains uncertain.  

In this study, I characterized the modern and historic surface hydrologic conditions of 

Ebey’s Prairie and their relationship to the local geomorphology. I used the Distributed 

Hydrology-Soil-Vegetation Model (DHSVM) to reconstruct the pre-agricultural surface 

hydrology and evaluate the effects agricultural drainage tiles have had on surface 

hydrologic conditions and aquifer recharge. A model representing Ebey’s Prairie 

watershed with was created, calibrated, and validated to stream discharge measured during 

my study. A second model was created to represent Ebey’s Prairie watershed without 

drainage tiles. Simulations for water years 2001-2010 for each basin condition were 

executed and compared to quantify the influence of drainage tiles on hydrologic regimes. 

Additionally, I mapped the local geomorphology, relating landforms to hydrologic 

regimes, and used lake sediment coring to improve the understanding of the sequence of 

events that created the unique landscape and its paleo-environment. 

Average annual surface discharge for Ebey’s Prairie watershed increased by 41,540 m3 

(10.97 million gal.) when artificial drainage was present in the model, an increase of 163 

percent over the pre-disturbance basin. The general shape of hydrographs was similar for 

both watersheds; however the basin with drainage tiles typically had peak flows 2-3 times 
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larger than the basin without tiles, in addition to greater hourly baseflows and a longer 

recessional curve.  

Average recharge for the entire Ebey’s Prairie watershed with drainage tiles was 19.9 

cm/yr. and without tiles was 20.3 cm/yr., an increase in recharge of 41,420 m3 or 1.65 

percent, which is within the margin of error for the model. It was determined that the 

effective drainage area of the Ebey’s Prairie watershed was smaller than the watershed 

boundaries as delineated by DHSVM. The effective drainage area largely contained both 

the silty loam and loam soils or in the silty loam soil only. The silty loam is coincident 

with the majority of the drainage tiles network and two closed depressions identified as 

relict marshes. The distribution of an additional 41,418 m3 of recharge across a smaller 

effective drainage area would result in an increase of between 1.0 to 9.8 cm/yr., which is 

significant. 

A geomorphic map of Ebey’s Landing National Historical Reserve was created, identifying 

20 distinct landforms covering an area of 72.7 km2. Eighty-six percent of the map area is 

composed of four map units: glaciated uplands, ice-marginal deltas, marine terrace and 

kame-kettle topography. 

Two sediment cores, 6.64 m and 9.24 m long, were collected from the Lake Pondilla kettle 

pond. I attempted to numerically date sediments deposited after kettle collapse to constrain 

the timing of events associated with the formation of the local geomorphology. Lack of 

extension rods during coring prevented recovery of deeper sediments. The recovered cores 

indicated a rapid sedimentation of 1.26 – 1.37 mm/yr through the mid and late-Holocene. 
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A tephra at 7.81 m could not be identified based on chemical analysis, however it is likely 

Mazama ash based on thickness, character and position within the sediment sequence.  
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1.0 INTRODUCTION 

Ebey’s Prairie is located within Ebey’s Landing National Historical Reserve (here after the 

reserve or EBLA), a U.S. National Park unit located on central Whidbey Island, Washington 

(Figure 1). The centerpiece of the reserve is Ebey’s Prairie (here after the prairie), a broad 

low surface approximately 6 km2 in size. Ebey’s Prairie has a long history of agriculture that 

predates European settlement, and currently supports three large farms. 

Present day surface water in the prairie consists of a small marsh remnant and an intermittent 

seasonal creek. Little is known of the original surface and shallow-groundwater flow within 

Ebey’s Prairie (USDI, 2006). Historic descriptions of the area from settlement to the mid-

1900s characterize the prairie as “marshy” and “waterlogged” (Kellogg, 2001). It is thought 

that the prairie was once bisected by a broad riparian corridor consisting of waterlogged 

soils, swampy areas, seasonal ponds, and intermittent flows, which helped recharge the local 

aquifer (USDI, 2006). By the mid-1900s, agriculture drainage tiles, drainage ditches, and fill 

were being installed by local landowners to increase tillable acreage. The extent and location 

of these drainage tiles or the effects these tiles have had on surface water and subsequently 

on aquifer recharge in the area remains uncertain.   

Most of Whidbey Island, except for the city of Oak Harbor, relies on the local groundwater 

aquifer for their water supply. The local aquifer depends on precipitation for recharge; 

however the region receives less than 530 mm (21 in.) of rain annually. In 1982, the EPA 

listed the aquifer as a “sole source aquifer”, underscoring the importance of the aquifer to the 

local communities. As population growth has increased, so has water demand; this is 

demonstrated by a 62 percent increase in water consumption between 1980-2000 (Island 
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County, 2005). By 1992, groundwater pumping had exceeded recharge and elevated chloride 

levels in local wells were being observed (Flora 1992).  

The geology of Whidbey Island and Ebey’s Prairie is dominated by unconsolidated glacial 

sediments, locally as thick as 1000 m (Jones, 1999). The prairie is part of an unusual 

glaciomarine kame-delta complex, and is bordered by two outwash deltas, a moraine, and 

kettles (Easterbrook, 1966; Carlstad, 1992; Figure 2). Local topography extends from sea-

level to upland stranded deltaic surfaces, a relief of approximately 60 m. The complex was 

created during an unusual series of events, which likely involved a readvance and 

reorientation of the Puget Lobe of the Cordilleran Ice Sheet (Carlstad, 1992; Dethier et al., 

2000; Polenz et al., 2004). Previous researchers have studied many of the unusual landforms 

located near the reserve; however, unlike other National Park units in Washington State, a 

complete geomorphic map does not exist for the reserve. In addition, although the timing of 

the glaciomarine kame-delta complex formation has been partially constrained by the 

radiocarbon dating of marine shells from neighboring deposits, there has been no direct 

dating of the Partridge Gravel, the sediment that comprises the kame-delta complex.  

The goal of this project is to characterize the modern and historic surface hydrologic 

conditions of Ebey’s Prairie, the influence of drainage tiles on hydrologic regimes and 

relationship between the unusual local geomorphology and hydrology. This research project 

was funded by the National Park Service (NPS). Understanding local water resources and 

surfaces processes is critical for resource managers. Knowledge of the hydrology and 

geomorphology of the reserve will assist the NPS in efforts to map soils, understand native 

prairie ecosystems, protect groundwater resources, manage land use, and restore native 

systems (USDI, 2007). Additionally, the Town of Coupeville is considering several storm-



 

3 
 

water management actions, including water impoundments in Ebey’s Prairie; a better 

understanding of local hydrology will help with planning (L. Smith 2007, personal comm.).  
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2.0 BACKGROUND 

2.1 Ebey’s Prairie Watershed 

The following section describes the geologic setting, climate, soils and modern landcover and 

vegetation of Ebey’s Prairie and central Whidbey Island, Washington.  

2.1.1 Geologic Setting 

Bedrock is exposed in only a few isolated locations, at the north end of Whidbey Island near 

Deception Pass. Bedrock is composed of Tertiary and older sedimentary, metasedimentary, 

and igneous rock. Unconsolidated Quaternary deposits in thickness ranging from tens of 

meters to greater than 1000 meters dominate the island. The thick variable deposits in part 

reflect a growing sedimentary basin related to a tilting downthrown fault block between the 

South Whidbey and North Whidbey Island fault zones (Gower, 1978; Cline et al., 1982). 

Quaternary Geology 

Quaternary deposits from at least three glaciations are recognized on Whidbey Island (Table 

1).  Most of the surface sediments and landforms on central Whidbey Island are composed of 

Vashon Stade and Everson Interstade deposits from the Fraser Glaciation (Carlstad, 1992). 

The Vashon Stade Drift present on central Whidbey Island is divided into two members: an 

advance outwash (sand and pebble-to-cobble gravel); and a till (Polenz et al, 2005).  The 

Everson Interstade deposits are time transgressive; they include a glaciomarine drift (GMD) 

and Partridge Gravel, a gravel and sand deposit (Easterbrook, 1966). 

Polenz et al. (2005) describes Ebey’s Prairie as being composed of an undivided GMD of 

mostly clay to silt-rich diamicton with gravel-sized clasts and marine shells. Glaciomarine 

drift sediments in the prairie reflect a period of submergence near a glacial terminus at the 
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end of the Pleistocene (Carlstad, 1992). Where exposed, the GMD is a poorly sorted pebbly 

silt, most commonly buff colored and is massive to rhythmically bedded. The deltas are 

composed of Partridge Gravel, a recessional outwash related to emplacement of the deltas; 

well logs suggest that the Partridge Gravel extends up to 41 m below sea level (Carlstad, 

1992). The Partridge Gravel type locality is located just north of Ebey’s Prairie; it is 

described as a moderately well sorted and stratified pebble to cobble gravel and sand 

(Easterbrook, 1966). Well logs suggest the undivided GMD deposits in the prairie are 

interfingered with Partridge Gravel deltaic deposits indicating GMD was deposited in an 

embayed Ebey’s Prairie synchronous with delta formation (Figure 3; Carlstad 1992, Polenz 

et al. 2005). A thin (~1 m) layer of GMD with emergence facies overlies much of the 

Partridge Gravel of the delta fronts, indicating a falling relative sea-level shortly after 

formation of the deltas. Stranded beach benches cut into the delta fronts, interpreted from 

LiDAR imagery, is consistent with emergent GMD.  

Covering most of EBLA is a 15 to 120 cm thick layer of fine late Pleistocene sand to silt.  In 

the south central portion of the Ebey’s Prairie, the late Pleistocene sand exceeds 150 cm. 

Pleistocene sand is likely wind-blown in origin and is well to very well drained. Small 

pockets of peat are mapped in the prairie and in the kettles, and surficial dune deposits occur 

along the southern margin of the western delta and kettles. These deposits overlay Vashon till 

and earlier deposits.  

Glacial History  

During the Fraser Glaciation, the Cordilleran Ice Sheet (CIS) advanced from source areas in 

British Columbia, crossing the latitude of the international border ~19,000 cal. yr. B.P. 

(Booth, 1987; Porter and Swanson, 1998). In the Puget Lowland, the CIS split into two lobes: 



 

6 
 

the Juan de Fuca Lobe and the Puget Lobe (Figure 4). The Juan de Fuca Lobe extended west 

along the Strait of Juan de Fuca, terminating on the continental shelf. The Puget Lobe, 

constrained by the Olympic and Cascade mountain ranges, extended south into the Puget 

Lowland.  

The Puget Lobe reached its maximum position near Olympia, WA around ~17,000 cal. yr. 

B.P. (14,500 14C yr B.P.; Porter and Swanson, 1998).  The Juan de Fuca Lobe reached its 

maximum extent on the continental shelf between approximately 17,000-18,000 cal. yr. B.P. 

(14,460 +/- 200 14C yr B.P.; Heusser, 1973). At its maximum extent, the ice sheet was 

approximately 1,370 m thick at Coupeville (Thorson, 1980), locally depressing the land 

surface more than 140 m (Dethier et al., 1995).  The ice remained at its maximum for only a 

few hundred years before rapidly retreating (Dethier et al., 1995).  The Juan de Fuca Lobe 

retreated rapidly from its maximum as a result of marine calving, eventually collapsing and 

allowing marine waters to enter Puget Lowland.   

Sometime after the collapse of the Juan de Fuca Lobe, the landforms around Ebey’s Prairie 

were deposited by a grounded ice front (Carlstad 1992; Polenz et al. 2005). The ice front was 

there long enough to create Penn Cove, the Coupeville Moraine and two ice-marginal deltas 

(Easterbrook, 1966). The deltas were deposited by glacial meltwater and the upper surfaces 

contain outwash channels that terminate at the delta fronts, which approximate the paleo-sea 

level at that time (Thorson, 1981).  During this time, Ebey’s Prairie was submerged and six 

to 15 m of glaciomarine drift was deposited from outwash and melting icebergs (Polenz et 

al., 2005).  Ice blocks, buried by proglacial outwash, melted to create local kettle-kame 

topography, most notably at Fort Ebey State Park, which includes numerous kettles and Lake 

Pondilla, a kettle pond.   
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Recent workers conclude that the collapse of the Juan de Fuca Lobe across the eastern Strait 

of Juan de Fuca and Admiralty Inlet may have initiated a reorientation and readvance of the 

Puget Lobe by over-steepening its western margin (Deither 2000, Polenz et al. 2005). 

Evidence of this event is preserved in the landforms of Whidbey Island. Southern Whidbey 

and Camano islands are dominated by north-south trending drumlins and streamlined hills. 

However, at lower elevations (<500 m) on northern Whidbey Island, the San Juan Islands 

and near Mt. Vernon these features have been overprinted by southwest-trending (225-260 

degrees) drumlins and glacial flutes (Dethier, 2000).  Deithier (2000) infers that the multiple 

orientations of flow indicators suggest a reorientation of flow direction of a thinning Puget 

Lobe from south to southwest during the margin collapse of the Puget Lobe approximately 

13,600 to 12,800 14C yr B.P. (uncorrected shell samples). 

As local sea level fell due to isostatic rebound, numerous marine strandlines were cut into the 

landforms on Whidbey Island at elevations up to 90 m above sea level (Dethier et al. 1995, 

Kovanen and Slaymaker, 2004).  Rapid emergence appears to have triggered landslides in 

Penn Cove and elsewhere (Polenz et al., 2005). Dunes formed on the deltas from wind 

deposited sand (Carlstad, 1992). As Holocene climate took hold, however, the landscape 

appears to have largely stabilized, with most of the landforms becoming relict.  

2.1.2 Climate 

The climate of Ebey’s Prairie is defined by its proximity to the Olympic Mountains and 

Puget Sound. The prairie is located within the rain shadow of the Olympic Mountains and 

receives an average of 528 mm (20.8 in.) of rain a year, compared to greater than 1016 mm 

(40 in.) on southern Whidbey Island. About 70 percent of annual precipitation occurs 

between October and April, periods of relatively low vegetative transpiration (Anderson, 
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1968). Precipitation falls primarily during high frequency, low intensity storm fronts off the 

Pacific Ocean. Ebey’s Prairie has a maritime climate, with air temperatures moderated by the 

Puget Sound. The mean annual average temperature is 10 oC, the average maximum summer 

temperature (Jun.-Aug.) is 21 oC and the average minimum winter temperature (Dec.-Feb.) is 

1.7 oC. The absolute minimum and maximum temperature ranges from -18 to 32 oC. Cloud 

cover averages 255 days per year with only 43 days of clear skies (USDI, 2007). To the east, 

the Cascade Mountains typically block cold, dry continental winds. The prevailing wind 

direction is from the south and southwest during the fall and winter and from the west and 

northwest during the spring and summer.   

There are two weather stations located within the reserve: Washington State University’s 

Whidbey station (WSU-Whidbey) and the National Weather Service’s Coupeville 1S 

Cooperative station (Coupeville COOP). The WSU-Whidbey station has been in operation 

since July 2006, hourly parameters measured include precipitation, air temperature, wind 

speed, relative humidity, and solar radiation (Figure 5). The Coupeville COOP station has 

been in continuous operation since 1948 measuring daily precipitation and air temperature.  

In addition, there are several weather stations outside the reserve. The National Weather 

Service (NWS) operates a weather station at the Naval Air Station (NAS) near the city of 

Oak Harbor, located 16 km north of Ebey’s Prairie. The NAS station was in continuous 

operation between December 1989 and May 2009; hourly parameters measured included air 

temperature and wind speed. WSU has operated a weather station in Mount Vernon (WSU-

Mt. Vernon), located ~30 km to the northeast of the prairie, since November 1993. Hourly 

parameters measured include precipitation, air temperature, wind speed, relative humidity, 

and solar radiation. The City of Bellingham has operated the Northshore weather station 
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(COB-Northshore), located ~55 km north northeast of Ebey’s Prairie, since December 2000. 

Hourly parameters measured include precipitation, air temperature, wind speed, relative 

humidity, and solar radiation.   

2.1.3 Soils 

A 1958 US Department of Agriculture (USDA) soil survey describes three prominent soil 

types that compose Ebey’s Prairie and three that compose the Smith Prairie delta. 

Collectively, these soil types compose 67 percent of the Ebey’s Prairie watershed; the 

remaining 34 percent is composed of 18 minor soil types (Figure 6). 

Ebey’s Prairie 

The most extensive soil is Coupeville loam (0-3 percent slope) which comprises 21 percent 

of the watershed. The parent material of the soil is fine textured glacial sediments that were 

deposited in a marine environment. The soil is described as moderately well drained with 

slow internal drainage due to a fine textured substratum. The soil has a high water-holding 

capacity and unless drained the lower subsoil is saturated during the winter. The soil profile 

consists of a black friable granular loam in the upper 25 cm (10 in.), developed from grass 

vegetation. A sharp boundary marks the transition to a light sandy clay loam between 25 and 

46 cm (10- 18 in.) which transitions into a sandy loam. Below the sandy loam is a clay layer 

that extends into the substratum (USDA, 1958).  

 Ebey’s sandy loam (0-5 percent slope) is very permeable, with slow surface runoff and rapid 

internal drainage, comprises 6 percent of the watershed. The soil profile consists of a sandy 

loam from 0- 46 cm (0-18 in.), fairly uniform medium sand from 46 – 91 cm (18-36 in.), and 

below 91 cm (36 in.) is course loose sand.  
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The least extensive of the three is Coupeville silt loam (0-2 percent slope), which comprises 

3 percent of the watershed.  It is similar to Coupeville loam but located at lower position and 

has a difference surface texture and shallower depth to clay. During the winter, the water 

table is near the surface and dries out later in the spring than the Coupeville Loam. The soil 

profile consists of a silt loam from the surface to 23 cm (9 in), from 23 - 31 cm (9-12 in.) is a 

sandy loam or a sandy clay loam, from 31 - 91 cm (12-36 in.) is a very plastic clay layer, and 

below 91 cm (36 in.) is finer clay layer.  

Additionally, the 1958 USDA soil survey states that the Coupeville loam is mostly being 

drained by agricultural tiles and ditches and recommends further drainage.  

Smith Prairie Delta 

Along the leading edge of the delta is Casey fine sandy loam (0-5 percent slope), which 

comprises 16 percent of the watershed and formed in parent materials till and GMD. The soil 

is moderately well drained with slow internal drainage. The top soil layer is a sandy loam 

which grades to a fine sandy loam at 6 inches. Between 41 and 46 cm (16-18 in.) there is a 

sharp transition to a compact clay, silty clay or silty clay loam, and is continuous to 61-91 cm 

(24-36 in.). Below which is porous gravel and sand.  

Hoypus coarse sandy loam (0-5 percent slope), which comprises 15 percent of the watershed. 

Developed from pebble gravel dominated glacial outwash, it is excessively drained with 

rapid internal drainage. The soil profile consists of a coarse sandy loam from the surface to 

20- 25 cm (8-10 in.), which transitions into coarse loamy sand. At 46 cm (18 in.) the soil 

becomes a gravelly sand before transitioning to a gravel and sand.  
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The least extensive soil type is the San Juan coarse sandy loam (0-5 percent slope), which 

comprises 6 percent of the watershed. Developed from gravel dominated glacial outwash, it 

is excessively drained with rapid internal drainage. The soil profile consists of a coarse sandy 

loam from the surface to 15-31 cm (6-12 in.), which transitions into a very gravelly loamy 

sand. From 46 to between 61 and 76 cm (18to 24-30 in.) is a gravelly sand or sandy gravel, 

below which is gravel and sand.  

2.1.4 Modern Landcover and Vegetation 

Whidbey Island is within the western hemlock zone of western Washington. Most of the 

wooded areas were logged or burned by 1900 (USDI, 2007). The current woodlands are 

second and third growth Douglas fir, western red cedar, and red alder, with thick underbrush 

of salal, Oregon grape, and ferns. Rhododendron and Pacific Madrone are also native species 

common to central Whidbey (USDI, 2007). The USGS National landcover dataset describes 

the upland deltas as being composed of a mix of coastal coniferous forest, mixed forest with 

some grassland. Ebey’s and Smith prairies are composed primarily of grassland, cropland, 

urban areas with a small amount of wetland.  

Ebey’s Prairie is one of many “anthropogenic prairies” identified along the west coast of 

Washington and Oregon (Weiser, 2006). Defined by grassland vegetation, these prairies 

formed during the early Holocene, in a warmer and drier climate. Prairie extent began to 

shrink as the climate cooled during the mid-late Holocene, sparking a change in vegetation to 

trees. Indigenous people maintained the open areas through selective burning. Continued 

indigenous and European agricultural practices have keep trees from encroaching into Ebey’s 

Prairie (Weiser, 2006). 
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2.1.5 Water Resources 

Surface Water and Drainage Tiles 

Present day surface water in Ebey’s Prairie consists of a small marsh remnant and a seasonal 

creek (Figure 7). The natural course of the seasonal creek (here after Ebey’s Prairie stream) 

has been modified significantly. The upper reaches have been routed into a network of 

drainage tiles and buried. The lower reaches of the stream follows a course for 0.5 km that 

has been ditched and straightened, before draining into Admiralty Inlet in the Strait of Juan 

de Fuca.  

Drainage tiles are a type of subsurface drainage typically used in agriculture to dry 

waterlogged soils. Traditionally, these tiles were sections of clay pipe fitted together; modern 

tiles are composed of perforated plastic piping. Typically, the tiles are buried at a depth of 

0.7 to 0.9 m (Zucker and Brown, 1998).  

The Island County Public Works Department has digitized the surface water drainage 

network for the county, including 11.3 km of drainage tiles in Ebey’s Prairie. I confirmed 

these locations with a local landowner (A. Sherman 2008, personal comm.). Municipal 

features have been linked into the drainage network, including the roadside drainage ditches 

along Engle Road (D. Kelly 2007, personal comm.).   

Groundwater Resources 

The majority of Whidbey Island wells yield water from sand and gravel deposits located 

between 10 m above sea level to 60 m below sea level. Referred to as the sea-level aquifer, 

these deposits are largely continuous across Whidbey Island, including Ebey’s Prairie. 
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Smaller non-continuous aquifers located above the sea-level aquifer occur on northeast and 

southeast Whidbey Island (Cline et al., 1982).  

Groundwater resources of Whidbey Island are experiencing increased demand and it is 

predicted future demands will not be meet in some locations. Whidbey Island has 

experienced significant increases in population since the 1950s, with the current population 

more than 58,000, including 1,700 in the Town of Coupeville (US Census Bureau, 2000). 

Island County has estimated average water use per person at 90 gallons per day, with a peak 

of 250 gallons per day (Island County, 2003). 

2.2 Previous Work 

2.2.1 Hydrologic Studies 

Effects of Drainage Tiles on Surface Water   

Installation of drainage tiles became a widespread practice in the early 1800s. Not long 

afterwards, debate began regarding impacts of drainage on river flood events. Many of the 

early claims were based on perceived changes; observations included more extreme highs 

and lows in river discharge and earlier flood peaks (Denton 1862). Modern debate is still 

largely focused on drainage related to flooding, however the impacts of drainage tiles remain 

unresolved.  

One view is that drainage tiles increase water movement towards stream channels thereby 

increasing peak flows. This is supported by O’Kelly (1955), who found a three-fold increase 

in peak discharge and a 1/3 reduction in time to peak after drainage tiles were installed in a 

watershed in Ireland. Similar results were observed by Baily and Bree (1980), with a 
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doubling of peak discharge and a 1/3 reduction in time-to-peak after drainage tiles were 

installed in 12 watersheds in Ireland. Weir (1949) suggested that drainage tiles temporary 

increase the moisture holding capacity of the soil, by drying out otherwise saturated or near 

saturated soils. Also water routed through the soil column is not synchronized with the 

surface runoff thereby reducing peak flows.  

Robinson (1980) argued that hydrologic response was driven by soil type and rainfall regime. 

Robinson analyzed data from six basins to determine the influence of drainage. Drainage tiles 

in lower permeability soils resulted in lower flow peaks because they tend to have larger 

overland flow. Further, drainage of the soil creates larger storage capacity and slows water to 

the channel. In contrast, soils with greater permeability are less prone to overland flow from 

surface saturation and the installation of drainage tiles resulted in greater peak flows. 

Robinson also noted that in locations with greater rainfall, the use of drainage tiles resulted in 

lower peak flows and greater baseflows. Hann and Johnson (1968) modeled the effects of 

drainage tiles on discharge. Like Robinson, the results were correlated to rainfall, with low 

intensity, long duration rainfall resulting in increased peak flow and increased drainage. No 

change was observed for high intensity rainfall. 

Deboer and Johnson (1969) noted that basins with subsurface drainage tiles had a greater lag 

time in discharge; hydrographs had a longer slope in the recessional curve. This was 

supported by Skaggs (1982) stating that flow from soils with drainage tiles will occur over a 

longer period than soils without tiles. The Drainage Guide for Ontario (OMAFRA, 1975) 

stated the drainable porosity of local soils is between 2 and 10 percent. For drainage tiles 

with a typical depth of 0.75 m, the soil column can store 15 to 75 mm of water, which drains 
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in about 2-days. Mason (1951) suggested the water table should drain below the drainage tile 

in 3-4 days compared to several weeks for an undrained soil.  

Other observations included Whiteley (1979), who stated that drainage of water in 

depressions reduces water lost to deep percolation and evaporation. Drainage of non-

overflow depressions increases the effective area of the watershed, thereby increasing 

volume and flood peaks.  

Groundwater Recharge 

Anderson (1968) described the general hydrologic setting of Whidbey Island including the 

availability and location of groundwater. The groundwater aquifers in Whidbey Island exist 

in Pleistocene glacial and interglacial deposits. Local glacial marine drift is likely non-water 

bearing, recessional gravels have high yields of 379 liters per minute (100 gpm), and glacial 

till are aquicludes having slow infiltration. Anderson analyzed well logs and water samples 

from wells throughout the county. More than half the wells studied access aquifers located at 

sea level to 22.9 m below sea level. Of these wells, ten were located within Ebey’s Prairie, 

water table heights ranged from 26 m above sea level to 14 m below sea level. Anderson 

analyzed the groundwater response to rainfall events; some wells had a nearly immediate 

response while others showed lag times of 1-5 months. Most of the groundwater discharge is 

through spring flows in sea cliffs and submarine springs.  

Cline et al. (1982) used existing groundwater data for Whidbey Island to identify where 

overpumping was occurring or likely to occur. Locations of saltwater intrusion were 

determined when chloride concentrations in wells exceeded 190 mg/l. Cline tested over 330 

wells in the April and August of 1980, including 121 wells that were identified in a July 1978 
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study as having elevated chloride levels. The highest chloride concentrations were in August 

and ranged from 10-1,240 mg/l, with concentrations exceeding 190 mg/l in 32 wells. Six of 

the contaminated wells were located in central Whidbey Island, including three along the 

western shore of Penn Cove. Chloride levels of eight wells that were sampled in Ebey’s 

Prairie did not exceed 190 mg/l. Eighty-six of the resampled wells showed an increase in 

chloride levels.  

Additionally, Cline et al.(1982) simulated aquifer recharge for Whidbey Island using a finite-

difference model and estimated it at 12.4 cm/yr (4.9 in/yr). They estimated that 

approximately 60 percent of precipitation is lost to evapotranspiration, approximately 24 

percent is available for recharge, and the remaining 16 percent is runoff. Annual groundwater 

levels fluctuated an average of 0.9 m from 1963-1965, as determined from four wells, 

including one located on Ebey’s Prairie (31/1-5H1). The digital flow model was also used to 

determine the location of the seawater-freshwater interface; near Coupeville its maximum 

was estimated to be 594 m below sea level.  

Sapik et al. (1988) divided the glacial and interglacial deposits in Whidbey Island into five 

aquifers and five confining units (Table 1). Aquifers were identified in Partridge Gravel, 

Olympia Interglacial deposits and Esperance Sand, and Whidbey Formation. Confining units 

were identified in Vashon Till, Possession Drift, and Whidbey Formation. Sapik created a 

three-dimensional groundwater flow model to simulate flow in a multi-layered aquifer 

containing fresh and seawater. Total recharge for Whidbey Island was estimated to be 24.99 

cm/yr (9.84 in/yr).1 Most groundwater was pumped from aquifers in the Whidbey Formation 

                                                           
1
 Sapik et al. (1988) provides recharge as 144 ft

3
/s. Annual recharge was calculated by converting ft

3
/s to ft

3
/yr 

and then divided the product by area of Whidbey Island as provided (165 mi
2
). 
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and Olympia Interglacial and Esperance Sand units, with a total pumpage estimated to be 

0.14 m3/s (5 ft3/s) in 1981.  Well measurements indicated that groundwater levels change 

seasonally with high levels in late winter and low levels in late summer, corresponding with 

timing of peak and low precipitation. Sapik estimated horizontal hydraulic conductivity of 

aquifers ranged from 2.87 x 10-5 to 2.87 x 10-3 m/s (9.4 x 10-5 to 9.4 x 10-3 ft/s), and 

horizontal hydraulic conductivity of confining layers as 3.05 x 10-8 m/s (1.0 x 10-7 ft/s). 

Vertical hydraulic conductivity for confining layers ranged from 3.05 x 10-10 to 4.57 x 10-9 

m/s (1.0x 10-9 to 1.5x10-8 ft/s). Sapik also suggested that much of the groundwater on 

Whidbey Island discharges through the seabed, most of the water recharged to the hydrologic 

system discharges from aquifers in the Whidbey Formation and Olympia Interglacial and 

Esperance Sand units. Only a small fraction of the recharge water moves downward below 

the Whidbey Formation aquifer.  

Sumioka and Bauer (2004) estimated groundwater recharge for Whidbey Island for the water 

years 1998-1999 using a deep percolation model (DPM) and a chloride mass balance method.  

Using the DPM, they simulated water budgets for six small basins, with the nearest basin to 

Ebey’s Prairie located along the north slopes of Penn Cove. Whidbey Island aquifer recharge 

averaged 14.5 cm/year. Recharge reflects the quantity of precipitation and distribution of 

surficial materials, with higher recharge occurring in areas underlain by coarser-grain 

deposits than by fine-grain deposits. Aquifer recharge in Ebey’s Prairie reflects the variety of 

soil groups, ranging from 0-10 cm/year for loams to 20-30 cm/year for sandy loams. 

Recharge for outwash delta deposits in the area are estimated to be 10-20 cm/year (USDA, 

1958; Sumioka and Bauer, 2004) 
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Island County, which includes Whidbey Island, has developed a groundwater database that 

includes well logs, stratigraphy and water quality data. Island County maintains a long-term 

monitoring network of wells throughout the county including two located in Ebey’s Prairie, 

and another 28 wells in and around the prairie that have sporadic data (D. Kelly 2007, 

personal comm.). Well depths in Ebey’s Prairie range from 16 to 384 feet below sea-level 

(well identifiers AEP and BFE, respectively). Well stratigraphy from Ebey’s Prairie indicates 

thick deposits of clay and glacial till interbedded with thinner lens of courser sand and gravel 

(Figure 3).  

2.2.2 Hydrologic Modeling 

Computer models are commonly used for understanding hydrologic processes, event 

responses, and hydrologic prediction. The hydrologic model used in this study is the 

Distributed Hydrology-Soil-Vegetation Model (DHSVM). The DHSVM is a physically 

based, spatially distributed hydrology model that simulates watershed hydrology (Figure 8). 

The model was developed at the University of Washington and the Pacific Northwest 

National Laboratory specifically for mountain watersheds on the west slope of the Cascades 

Mountain Range in Pacific Northwest (Wigmosta et al., 1994).  

Using GIS coverages for basin characteristics and meteorological inputs, the model simulates 

the spatial and temporal hydrologic conditions, including canopy interception, 

evapotranspiration (ET), snow accumulation and melt, surface water flow, and saturated and 

unsaturated groundwater flow. Models requiring GIS inputs are useful because complex 

spatially distributed basin and meteorological data can be easily represented and altered for 

different conditions. The DHSVM output data consist of 42 parameters (e.g., streamfow and 

evapotranspiration) that can be defined at any pixel within the watershed, for any time 
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period. Energy and water budgets are calculated using established hydrologic relationships 

from meteorological, soil, landcover and topographic inputs. Model applications have 

included streamflow forecasting, climate change and hydrologic effect of land management 

(e.g. Chennault, 2004; Kelleher, 2006; Donnell, 2007; Matthews et al., 2007; Dickerson, 

2010).  

Using Digital Elevation Model (DEM) topographic data, the modeled landscape is divided 

into computational grid cells. The DEM data are also used to define the topographic controls 

on meteorology, including absorbed shortwave radiation, precipitation, air temperature, and 

downslope water movement. Vegetation and soil properties are assigned to each grid cell. At 

each user-defined time-step the model provides energy and water budget solutions for each 

grid cell in the watershed. The individual cells are hydrologically linked through surface and 

subsurface flow routing (Wigmosta et al, 2002). Evapotranspiration is calculated by applying 

the Penman-Montieth equation to a two-layer canopy representation. In the absence of 

understory, evapotranspiration from the upper soil layer is simulated. Soil evaporation 

follows the soil-physics approach described by Entekhabi and Engleson (1989). Saturated 

and unsaturated subsurface flow is driven by hydraulic gradient and calculated using Darcy’s 

Law (Wigmosta et al., 2002). 

2.2.3 Geomorphic Studies 

Easterbrook (1963, 1966, and 1968) was the first to describe the unusual geomorphology on 

central Whidbey Island. He identified the kettle topography, the two terraces to the east and 

west of Ebey’s Prairie, and the sand dunes along the southwestern margin of the western 

terrace. Easterbrook also characterized local deposits associated with these landforms 

including Partridge Gravel and Everson GMD.  
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Carlstad (1992) interpreted the two terraces and relict channels as ice-contact deltas that were 

constructed in marine water with a paleo-sea level of 55 meters above present sea-level. 

Narrow benches located on the delta fronts and other upland surfaces are strandlines that 

occurred when relative sea level dropped because of isostatic rebound. Sediments composing 

Ebey’s Prairie are bottomset beds of the two deltas. Carlstad noted that although lodgement 

till is widespread to the north and south of Ebey’s Prairie, locally it is sparse. Carlstad also 

suggests that the unique east-west orientation of Penn Cove, compared to dominant north-

south orientation in the Puget Lowland, indicates that it did not exist prior to Vashon 

recession.  

Deither (1995, 2000, and 2005) suggested that the cross-cutting striations located on northern 

Whidbey Island are a product of a reorientation of ice flow in response to calving glacier 

margins. Deither suggests Penn Cove was carved out during a readvance with a SW flow 

direction. Diether also suggests that the GMD was deposited by subaqueous outwash in ice 

proximal zones, and by icebergs, meltwater and currents in transitional and distal zones.  

Kovanen and Slaymaker (2004) used LiDAR data to further delineate fluting, ice flow 

patterns, shorelines, deltas, and paleo-channels on Whidbey Island. Two paleo-channels are 

mapped in EBLA, one through Ebey’s Prairie and another along the western margin of the 

Smith Prairie delta. Distributary channels on the deltas appear unmodified by wave action 

indicating that isostatic rebound outpaced sea-level rise.  

Polenz et al. (2005) mapped the geology of Ebey’s Landing National Historical Reserve at 

1:24000 scale. Polenz notes that the Coupeville moraine, the moraine located between the 

two deltas, extends under the deltas. 



 

21 
 

The U.S. National Park Service has mapped the geomorphology of other national park units 

in Washington, including North Cascades and Mount Rainier national parks and is the 

process of completing Olympic National Park (Riedel et al., 2010 and in review). The NPS 

uses a scheme of thirty-seven distinct landform units in mapping at a 1:24000 scale.  

Landform units are based geologic processes and are associated with changes in topography, 

hydrology, soil and plant assemblages.  

2.2.4 Relative and Numeric Dating Studies  

Easterbrook (1968) constrains the age of Partridge Gravel, which composes the kame-kettle 

topography and deltas, between the retreat of Vashon ice and the deposition of Everson 

GMD. This is inferred from an exposure of a Partridge Gravel and Everson GMD contact at 

West Beach in which Partridge Gravel appears to underlie and therefore predate GMD. 

From well logs, Carlstad (1992) concluded that the Partridge Gravel and Everson GMD are 

inter-fingered and therefore coeval. Carlstad suggests the Everson GMD was locally 

deposited in the latter stages of Partridge deposition, when relative sea level was lowering 

because of local isostatic rebound; although the sea level was at 55 m during the Partridge 

deposition, the Everson GMD is not found above 37 m. 

Most numeric dating of local geomorphology has been associated with marine shells 

contained in the Partridge Gravel and Everson GMD. Easterbrook (1966 a,b) first noted the 

shell fragments potentially in growth position in Everson GMD exposures on the north side 

of Penn Cove. Radiocarbon analysis of marine shells collected locally from the Everson 

GMD return ages of 11,850+/-240 to 13,650 +/-350 14C yr. BP (Easterbrook 1966, Dethier et 

al. 1995, Swanson 1994). The Everson Interval began when the retreating glacier thinned 
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allowing marine waters to invade the Puget Lowland and ended when isostatic rebound 

exceeded sea-level rise. The youngest date indicating glacier ice in the Strait of Juan de Fuca 

is 13,600 14C yr B.P. (Pessl et al., 1989). Swanson (1994) dates the end of the Everson 

Interstade locally at around 12,640 14C yr. BP. 

Suggested marine reservoir correction for radiocarbon dating of shells in the area is between 

400 and 800+25 years (Swanson, 1994; Kovanen and Slaymaker, 2004). 

Carlstad unsuccessfully tried to constrain the timing of delta formation using 

tephrachronology. Tephra was collected from Partridge Gravel, however, geochemical 

analysis could not verify the source; however, Glacier Peak was unlikely based on 

geochemical results.   
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3.0 RESEARCH OBJECTIVES 

I characterized the modern and historic surface hydrologic conditions of Ebey’s Prairie, 

Washington and its relationship to the unusual local geomorphology of Ebey’s Landing 

National Historical Reserve. This project used a numerical hydrologic model, the Distributed 

Hydrology-Soil-Vegetation Model, along with existing data and field data to reconstruct the 

pre-agricultural surface hydrology and quantify the effects agricultural drainage tiles have 

had on surface hydrologic conditions. The project provides an elementary integration 

between surface water and existing groundwater models. 

I mapped the geomorphology of Ebey’s Landing National Historical Reserve. Methods 

followed those outlined by the US National Park Service at other parks in Washington State. 

They include use of field observations, LiDAR, previous research and other spatial data. 

The project used lake sediment coring to improve the understanding of the sequence of 

events that created the unique landscape and its paleo-environment. I attempted to use 

numerical dating techniques to constrain the timing of the events associated with the 

formation of the unusual local geomorphology.  
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4.0 METHODOLOGY 

My research can be divided into three steps: hydrologic modeling, geomorphological 

mapping, and sediment core analysis. In the following section each step is divided into a 

series of tasks; the methods for each task are then described in detail.  

4.1 Hydrologic Modeling 

The following tasks for creating a calibrated DHSVM model of Ebey’s Prairie watershed 

were completed: (1) create GIS data sets representing basin characteristics to be used by the 

model; (2) measure stream discharge; (3) collate meteorological data; (4) calibrate and 

validate the model and (5) execute watershed experiments. These tasks are described in 

further detail in the following sub-sections.  

4.1.1 Basin Setup 

Basin setup involved using ESRI ArcGIS 9 software to create two sets of spatial data, one 

representing modern basin conditions with drainage tiles present (modern) and one without 

drainage tiles present (historic). The datasets are used to assign spatially distributed model 

input parameters to the watershed DEM. The datasets are then converted to ASCII format for 

DHSVM input.  

Each dataset contains seven grids representing basin topography and land surface: (1) 

topography; (2) watershed boundary mask; (3) flow network; (4) soil texture classification; 

(5) soil thickness; (6) landcover and vegetation; and (7) road network. The modern and 

historic datasets contained identical grids with the exception of the topography and stream 
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network grids. An overview of the methods used to create each grid is described below. See 

Appendix A for a detailed description of basin set-up methods.  

Topography 

Basin topography is represented using a Digital Elevation Model (DEM). The DEM is the 

foundation for DHSVM and is what the distributed parameters are based on (Storck et al., 

1995). Many inputs are calculated directly from the DEM, including watershed boundaries, 

stream network, flow direction, flow accumulation, and topographic shading maps. The 

DEMs for Ebey’s Prairie watershed were created from Light Detection and Ranging 

(LiDAR) data for central Whidbey Island provided by the Puget Sound LiDAR Consortium 

(http://pugetsoundlidar.ess.washington.edu/). The data files were converted into raster files 

and merged into a single DEM. The DEMs were then resampled to a courser 10 m X 10 m 

grid resolution, to increase the processing speeds. 

Using the resampled LiDAR grid, two DEMs were created; one representing historic 

conditions without drainage tiles and one representing modern conditions with drainage tiles 

(Figure 9 and 10). No spatial data exists of the historic surface hydrology; therefore the 

LiDAR grid was used as an adequate representation of the watershed without tiles present. 

Subsurface drainage tiles cannot be directly simulated using DHSVM. Instead, the LiDAR 

grid was modified to represent the buried drainage network as an open drainage channel. An 

ArcGIS shapefile of drainage tile locations was used to “burn” the network into the original 

DEM. Burning is the process of modifying a DEM by imposing linear features on it; in this 

example, creating an artificial channel representing the drainage network on the DEM.  
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To “burn” the drainage network into the DEM, the drainage tile shape file was converted to a 

raster file and resampled to a 10 m X 10 m resolution. Pixel values were then reclassified, 

with drainage tile pixels equal to one and no data pixels equal to zero. The elevation values in 

the original DEM pixels were then subtracted by the pixel values in the drainage tile raster 

using the ArcGIS raster calculator. The result was a DEM where pixels located along the 

drainage network route were one meter lower in elevation than the original DEM, or the 

approximate depth below surface of the tiles. Additional rounds of burning were necessary to 

lower individual “high spot” pixels along the drainage network, ensuring lower order stream 

segments flowed into higher order segments.  

Watershed Boundaries  

Watershed boundaries were generated for a user-defined drainage point using the ‘Hydrology 

Modeling’ tool in ArcGIS. The stream outlet was selected as the drainage point; the 

watershed polygon that was created included all pixels above that point. The watershed was 

used as a “mask” or template to clip other grids to the watershed, including the DEMs, soil 

texture and landcover grids. This insured that all input grids contain the same number of 

overlapping pixels. The modern and historic watershed boundaries are assumed to be 

identical. 

Stream Network 

An ARC Macro Language (AML) script from the University of Washington (UW) was used 

to create stream networks based on topography from each respective DEM. Stream networks 

are modeled as a series of linear reservoirs or reaches. Each reach is assigned attributes such 

as channel width, depth and roughness (Storck et al., 1998).  
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Two stream networks were created representing historic and modern conditions. For the 

modern conditions, the GIS drainage tile layer provided by Island County was used to define 

the extent of the modern stream network (Figure 11 and 12). For the historic stream network, 

since no data exists defining the native stream network, a network was estimated. The native 

stream network was determined based on the best understanding of soil types and 

geomorphology. 

The relict landforms in the watershed, such as outwash channels on the deltas, resulted in 

segments of the stream networks representing relict flow regimes. The stream networks were 

checked for accuracy and then modified when necessary. Stream networks created using 

these AML scripts have provided acceptable results for mountainous watersheds in Pacific 

Northwest environments (e.g., Wigmosta et al., 2002; Chennault, 2004). 

Soil Texture Classification 

DHSVM requires data for a number of soil-dependent hydrologic parameters, including 

porosity, field capacity, wilting point, and vertical hydraulic conductivity for each pixel. 

These are determined by the dominant soil type for each cell. Cells with identical soil classes 

are assigned identical soil dependent hydrologic parameters (Storck et al., 1995).  

The modern and historic soil textures are assumed to be identical; therefore a single grid was 

created for both. A soil texture grid for Island County was generated from the 1958 Island 

County Soil Survey and downloaded from the USDA State Soil Geographic database 

(STATSGO). The downloaded soil texture grid was converted to a raster image, resampled to 

10 m X 10 m resolution and clipped to the watershed. DHSVM cannot accommodate all the 

soil categories identified by the USDA that exist in Ebey’s Prairie watershed; therefore the 
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USDA soil classifications were grouped into corresponding DHSVM soil classifications 

(Figure 13).  

Soil Thickness 

For the Ebey’s Prairie watershed model, soil thickness includes both soil and the 

unconsolidated material below. The modern and historic soil thicknesses are assumed to be 

identical; therefore a single grid was created for both. A soil thickness grid did not exist for 

the watershed. ARC Macro Language programs (AMLs) created by UW were used in 

ArcGIS to simulate soil thickness based on degree of slope and flow accumulation 

determined from the watershed DEM. Soil thickness estimates for an area with shallow 

slopes and high flow accumulation will be thicker than for an area with steep slopes. This 

technique for estimating soil thickness is a generally accepted technique in mountainous 

watersheds in Pacific Northwest environments (Wigmosta et al., 2002; Chennault, 2004). 

The AML requires a user-defined minimum and maximum soil depth. A soil depth range of 5 

to 15 meters was selected, representative of the thick unconsolidated sediments and the deep 

regional water table (Figure 14).  

Landcover 

DHSVM requires data for a number of vegetation-dependent hydrologic parameters, 

including leaf area index, height, stomata conductance, radiation, and wind speed decay 

coefficient. The modern and historic landcover is assumed to be identical; therefore a single 

grid was created for both.  

A landcover grid of dominant overstory vegetation type was created from 30 m resolution 

Landsat Thematic Mapper and Landsat Enhanced Thematic Mapper satellite imagery from 
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2001 and provided through the NOAA Landcover Database (www.mrlc.gov). The landcover 

grid was converted to a raster image, resampled to 10 m X 10 m resolution, and clipped to 

the watershed. The NOAA landcover classifications were converted to the corresponding 

DHSVM landcover classifications (Figure 15).  

Road Network 

Road GIS data, created by the Washington State Department of Transportation, was provided 

by the NPS. The road network was clipped to the watershed boundaries and reclassified into 

one of three DHSVM road classes. Each road class contained unique values for road width, 

road ditch width and road cut slope height. AML scripts from the UW were used to create 

road crossing structures (culverts), identify basin edges, and populate road input files for 

DHSVM (Figure 16). Although the road network has changed since the drainage tiles were 

installed, no distinction was made between historic and modern conditions. 

4.1.2 Stream Gauging Station and Discharge Measurements 

Stream discharge is necessary for calibrating and validating the DHSVM model. Initially, 

there were no stream discharge data available for Ebey’s Prairie stream.  Using stage heights 

and instantaneous discharge measurements, a rating curve can be created to estimate near-

continuous stream discharge. In November 2008, I installed a Global Water WL15 pressure 

transducer to meet these needs. The pressure transducer provided stage height as a function 

of pressure in user-defined increments; a time-step of 15 minutes was chosen. Instantaneous 

discharge was measured by timing the rate a five-gallon bucket filled from a culvert located a 

few meters upstream of the gauge. Near continuous stream discharge estimates were then 

available for calibrating the model. 
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In addition, groundwater heights were measured at three wells distributed across Ebey’s 

Prairie, in an effort to identify relationships between groundwater and surface water (Figure 

7). Measurements were collected in the late spring and fall to quantify annual maximum and 

minimum water levels. The selected wells were drilled to a depth of 31, 50 and 409 feet 

below sea level (wells DFT, 363 and BFE respectively).  

4.1.3 Meteorological Data 

DHSVM requires a minimum number of meteorological inputs from a location in or near the 

watershed, these are: precipitation, air temperature, relative humidity, incoming long and 

shortwave radiation, and wind speed. Point weather measurements are distributed across the 

watershed using a constant precipitation-elevation lapse rate, and a constant temperature 

lapse rate. Topographic controls on meteorological variables, such as incoming longwave 

and shortwave radiation, are adjusted by DHSVM.   

A ten year meteorological record was compiled from local weather stations for water year 

(WY) 2001 through WY 2010. No local weather station had a complete data series for the 

weather parameters needed by DHSVM during this period; therefore it was necessary to use 

multiple data sources to complete the record. In general, data from the closest weather 

stations were used if data was missing or suspect. In order of proximity to Ebey’s Prairie, the 

data from the following weather stations were used: (1) WSU-Whidbey, (1) Coupeville 

COOP, (3) Oak Harbor NAS, (4) WSU-Mt. Vernon and (5) COB-Northshore.  

Meteorological data from the WSU stations were available as non-quality-controlled data 

only and were downloaded from WSU’s AgWeatherNet website 

(www.agweathernet.wsu.edu/ awn.php) The Coupeville COOP and NAS station data have 



 

31 
 

been quality controlled by the NWS and downloaded from the National Climatic Data Center 

(www.ncdc.com). Weather data from COB-Northshore was provided by the COB as a 

complete quality controlled dataset. Longwave radiation data was not available from any 

station; instead it was calculated and provided by Robert Mitchell, Ph.D. Average annual 

longwave radiation averaged 2.94 M w2. 

I performed quality control to identify suspect or missing data. Suspect data were identified 

by comparing graphed and summarized data from multiple sites.  If trends or totals in 

parameter values varied beyond expected normal ranges for a period and similar departures 

from normal were not observed at other nearby stations, then the data was classified as 

suspect for that period. 

Table 2 lists the weather data sources used in modeling by parameter and year. All 

parameters contained some suspect or missing data, usually lasting no longer than a few 

hours. Relative humidity and precipitation from the WSU-Whidbey station was the 

exception, with suspect data lasting multiple years. The quantity of suspect data was 

extensive enough, that all WSU-Whidbey station relative humidity and precipitation data was 

considered suspect. For relative humidity, suspect data were replaced with the next closest 

station, primarily WSU-Mt. Vernon.  

Replacing suspect precipitation data was more problematic, neither the Coupeville COOP nor 

the NAS station collected hourly precipitation for the simulation period. Due to strong 

precipitation gradients in the Puget Lowlands, meteorological stations located further away 

are not representative and could not be used. Data analysis indicated that although the WSU-

Whidbey precipitation totals were suspect for WY07-WY10, the frequency and relative 
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intensity of the hourly precipitation measurements were reasonable. Therefore a hybrid 

dataset was created disaggregating the daily precipitation totals from the Coupeville COOP 

site into hourly data based on hourly data from the WSU-Whidbey and WSU-Mt. Vernon 

stations. The hourly WSU precipitation data was converted into percent of the daily total for 

that hour, the total daily precipitation from the Coupeville COOP station was then applied to 

this percent of daily total. The result was a hybrid of the two stations, with the precipitation 

totals determined by the Coupeville COOP and the time of day and intensity determined by 

the WSU station.  

4.1.4 Initial Conditions, Calibration and Validation 

DHSVM requires initial hydrologic conditions for each variable at the start of the simulation; 

this includes antecedent soil moisture that would naturally exist prior the simulation period. 

Typically these conditions are unknown. To account for these conditions, a simulation is 

performed using an initially dry watershed and one year’s worth of meteorological data.  The 

hydrologic conditions at the end of the simulation are then used as the initial conditions for 

simulations for the following year.  

Once the initial conditions are established, the model is calibrated to account for uncertainties 

in the system. Calibration is performed by inputting meteorological data for a specific period 

and comparing simulated and observed stream discharge data. Weather and stream discharge 

data is only available for the modern basin, therefore calibration and validation was 

performed for the watershed with drainage tiles only. Soil parameters, such as maximum 

infiltration and hydraulic conductivity, are adjusted to create best fits between the simulated 

and observed stream discharge. Soil properties and other constant parameters established 
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during calibration of the watershed with drainage tiles were used for simulations with the 

watershed without tiles. 

Model validation is an essential part of model development. The purpose of validation is to 

assess a models predictive ability outside the calibration period, ensuring the model can 

represent the watershed under different conditions. Model validation is performed by 

quantitative and qualitative comparison of observed and predicted stream discharge for a 

time series outside the calibration time series. If properly calibrated the simulated streamflow 

should adequately match the field measurements.  

4.2 Geomorphic Mapping 

A suite of 37 different landforms is currently being used by the NPS to map the 

geomorphology at other national park units in Washington State. Landform mapping of 

Ebey’s Landing National Historical Reserve followed similar methodology used by the NPS 

(Riedel et al., 2010). Landforms were identified and delineated using a combination of 

LiDAR imagery, soil and geologic spatial data, including the USDA 1958 soil map, 1998 

NAIP imagery and USGS 7.5 minute quads. Previous studies for the area were also 

referenced in locating and identifying landforms (Easterbrook 1966, 1968; Domack 1983; 

Carlstad 1992; Dethier et al. 1995; Kovanen and Slaymaker 2004; Polenz 2005). A NPS 

database of landform types and definitions used by the NPS mapping project was used for 

identifying landforms at EBLA, with additional landforms added to the database when 

necessary. Individual landforms were identified by slope, topography and geometry from the 

LiDAR hillshade. Although, landforms were readily identified from available data, field-

verification of some landforms was conducted. Digitizing of landform boundaries was 

accomplished with using ESRI ArcGIS 9 software.  
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4.3 Sediment Core 

A sediment core was used in an effort to collect material that could be numerically dated to 

constrain the timing of the delta formation. Lake Pondilla, a 4-acre kettle pond with an 

adjoining marsh located at Fort Ebey State Park was chosen as a coring site (Figure 1). 

Preferred coring locations are in lakes and ponds because the stratigraphy tends to be better 

preserved. Lakes are less likely to be disturbed by bioturbation, also volcanic ashes and other 

fall deposits will be more uniformly deposited, with less environmental disturbances, such as 

wind.  

The deepest part of Lake Pondilla was chosen as a coring location. Cores are typically 

collected from the deepest parts of a lake because it is the most likely area to remain 

submerged during dry periods and therefore have the most detailed record. Lake water depth 

was measured at using a handheld depth sensor. 

A second coring site was chosen in the same kettle, in a shallow bog adjacent to Lake 

Pondilla.  

4.3.1 Core Collection 

A Livingstone piston coring device was used to collect the sediment cores. The Livingstone 

core is a hand-operated piston corer that consists of a 1.2 meter long by 51mm (2 inch) 

diameter core barrel. The core is driven into and removed from the sediments using a series 

of 1.5 to 2 m extension rods that attach to the core barrel.  

When collecting lake sediments the core is operated from an anchored raft, the core is pushed 

into the lake bottom sediments by operators at the surface. A 4-inch diameter ABS plastic 
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casing is lowered from the raft into the water column. The ABS casings are used as a guide 

to relocate the original coring hole when taking multiple pushes.  

The corer was pushed straight down in 1-meter increments, or until the sediments became too 

stiff or coarse to continue. Once extracted, the core’s recovered push length and core depth 

were measured. Each push was extruded into a split PVC pipe that was double-lined with 

household plastic wrap and then labeled with an identifier and orientation. The cores were 

transported directly to Western Washington University (WWU) and stored in a refrigerated 

room until analysis.  

4.3.2 Core Analysis 

Sediment core analysis included magnetic susceptibility, visual stratigraphy, loss on ignition 

for organic content, and tephrachronology.  

Magnetic Susceptibility 

Magnetic susceptibility (MS) provides a first-order approximation of the varying content of 

iron-bearing minerals in the sediment. MS is a unitless constant that is determined by the 

physical properties of the magnetic material. Magnetic susceptibility is measured by passing 

the core through an induced magnetic field, with a sensor determining the extent to which the 

sediments disturb the field, which induces a temporary low-level magnetization of the core 

(Nowaczyk, 2001). Measurements were taken at 2 cm intervals using a Bartington 

Instruments MS2 magnetic susceptibility meter. Variability in content and/or composition of 

iron-bearing minerals reflects changes in sediment composition or sediment source often 

related to climate variability. Higher MS values often correspond to greater clastic sediment 



 

36 
 

content, whereas lower MS can indicate greater organic content. MS was conducted at WWU 

within ten hours of extraction.  

Stratigraphic Analysis 

Visual stratigraphy provides a record of changes in the composition and character of 

sediment in a basin or lake. These changes can be a result of environmental or geomorphic 

changes. Periods of draught or fire history can be recorded in the sediments by decreases in 

organic content or increases in ash and charcoal, respectively. The cores were split in half 

length-wise and then I examined their stratigraphy, noting changes in organic content, 

sediment color, density and macro-fossils. Peaks in magnetic susceptibility values were used 

as an aid to locate strata in the cores. The sediment color was described using the Munsell 

color scheme. Core stratigraphy was recorded with digital imagery; photographs were taken 

every 10 cm for the entire core length. 

Loss on Ignition  

Loss on Ignition (LOI) provides a measure of organic content in a core. Changes in organic 

content generally reflect changes in local environmental conditions. During drier periods, the 

organic content in lake sediments decrease as plant growth decreases around the lake (D. 

Clark 2009, personal comm.).  Samples for LOI analysis were taken every 10 cm, with 

additional samples taken in areas of special interest, including locations with low and high 

magnetic susceptibility values or thinly bedded strata that would not otherwise be sampled. 

Each sample is weighed to determine the “wet weight”. The samples are then dried at 100 oC 

for 24 hours and reweighed to determine the “dry weight”. Wet and dry weights are 

subtracted to determine sample water content. The samples are then heated at 450 oC for 

three hours oxidizing volatile organics. The samples are allowed to cool and then reweighed 
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to determine the “post ignition weight”. Changes in mass between the dry weight and post-

ignition samples provide a measure of the amount of organic content.  

Tephra Identification 

Tephra layers provide distinct marker horizons that allow correlation of a sediment core to 

known volcanic events. Tephra layers are typically characterized by abundant microscopic 

glass shards that form thin distinctive buff to light grey colored beds in lake sediments. 

Tephra composition was analyzed with a Scanning Electron Microscope with an Energy 

Dispersive X-ray Spectrometer (SEM/EDS) at WWU. Tephra composition was compared 

with other known samples for similarities to identify the likely source. 

Radiometric Dating 

Any noteworthy macrofossils recovered from the sediment core were used for Accelerator 

Mass Spectrometry (AMS) radiocarbon dating; with radiocarbon ages being calibrated using 

the program CALIB v.5.0.  
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5.0 RESULTS 

5.1 Hydrologic Modeling 

5.1.1 Basin Setup 

Nine grids representing the Ebey’s Prairie watershed were created and successfully used to 

calibrate, validate and simulate basin hydrology under varying conditions. The Ebey’s Prairie 

watershed as defined by ArcGIS Archydro Tools is 12.4 square km with an elevation range 

of 2 to 71 meters. The watershed incorporates large portions of Ebey’s and Smith prairies. 

However, the kame-kettle complex to the west of Ebey’s Prairie and the south-western 

portion of Ebey’s Prairie are not part of the watershed. Five DHSVM soil classes exist in the 

watershed; sandy loam and loam are the predominant soils composing 90 percent of the basin 

(Table 3). Eight DHSVM landcover classes exist in the watershed; cropland, coastal conifer 

and urban are the largest units composing 85 percent of the basin (Table 4).  

5.1.2 Stream Gauging Station and Discharge Measurements 

A pressure transducer was successfully installed and stream stage data were collected at 15-

minute intervals from November 2, 2008 17:00 to August 29, 2009 18:00 and from October 

6, 2009 14:00 to May 7, 2010 17:00. The period of missing data was a result of a dead 

battery in the stream gauge. Sixteen instantaneous discharge measurements were collected 

between the period of January 18, 2009 and May 7, 2010. Instantaneous discharge ranged 

from 0.00 to 0.30 cubic feet per second (cfs) with corresponding stage values of 0.02 to 0.16 

feet (ft). Measured stage values ranged from -0.55 to 4.33 ft. A rating curve was created by 

establishing a relationship between discharge measurements and corresponding stage data 

(Figure 17). The rating curve was applied to the stage record to create a near continuous 
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discharge record (Figure 18). The 15-minute discharge data was summarized into 1-hr 

timesteps for use by the DHSVM model. 

Several periods of abnormally high stage height, short in duration, could not be attributed to 

a precipitation event and were classified as suspect and removed. This occurred as six events 

totaling 187 hours between July 27, 2009 10:00 and December 11, 2009 14:00. Five suspect 

events had maximum values for stage within the range of previous peaks; a sixth event had 

peaks outside the range of observed maximums. The source of the values could be equipment 

malfunction or possibly related to local agriculture such as irrigation; the sharp rise and fall 

of the event hydrographs were significantly different from other events suggesting an origin 

other than rainfall. Periods of negative stage heights were measured by the pressure 

transducer and were flagged as suspect; these occurred primarily during the summer months 

when the intermittent Ebey’s Prairie stream is typically dry, therefore negative stages values 

were converted to zero stage. A calibration check of the pressure transducer revealed no 

errors. 

For the period of record, stream discharge totaled 126.2 thousand (k) m3 (4.5 million [M] ft3); 

with an average of 0.003 m3/sec (0.09 cfs) and a range of zero to 0.04 m3/sec (1.29 cfs). 

Analysis of the hydrograph reveals a rapid stream response to precipitation events, which is 

reflective of short flow routing distances found in small drainage basins. Discharge is 

typically near zero for most of the summer, corresponding with seasonal drought conditions.  

Groundwater level measurements taken at several wells in the prairie (Table 5) in the spring 

and the early fall reflect maximum and minimum water level. The water table ranged 
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between 2.97 and 4.67 meters above sea level; and did not significantly change throughout 

the year. 

5.1.3 Meteorological Data 

A complete quality controlled weather dataset was created for the period of October 1, 2000 

to September 30, 2010 (Figure 19a-e). The primary source of meteorological data for water 

years 2001 through 2006 was the NAS and the WSU-Mount Vernon stations and for water 

years 2007 through 2010 was the WSU-Whidbey weather station (Table 2).  

For WY2001-WY2010, average annual precipitation averaged 528 mm (20.79 in.; 101 

percent of 1948-2005 normal), with a range of 380 to 623 mm (14.96-24.53 in.; Table 6). 

The minimum and maximum annual precipitation for the period of record (1948-2010) at the 

Coupeville station is 336 and 741 mm respectively (13.22 and 29.18 in.).  On average 64 

percent of precipitation occurred between October and March and the remaining 36 percent 

occurred between April and September. For the period of record, hourly rainfall occurred 

14.5 percent of the time. Hourly rainfall averaged 0.41 mm/hr. (0.02 in/hr.); the greatest 10 

percentile of rainfall averaged 2.27 mm/hr. (0.09 in/hr.).  

Precipitation for the calibration and validation was near normal, 102% and 107% 

respectively. However monthly totals differed from the normal; during the calibration period, 

October, June and August were significantly drier than normal and November and December 

were significantly wetter than normal 

For WY2001-WY2010, the average hourly temperature was 9.9 oC, with a range of -12.7 to 

32.7 oC. Hourly wind speed averaged 1.9 m/s with a maximum of 19.67 m/s. Relative 
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humidity averaged 84 percent. Average annual shortwave solar radiation totaled 1.20 M 

w/m2. 

5.1.4 DHSVM Calibration and Validation 

Calibration 

DHSVM calibration uses heuristic techniques, comparing observed discharge with predicted 

discharge values and adjusting basin parameters until a best fit between simulated and 

recorded values is reached. The initial values used for soil, vegetation and constant 

parameters were the default parameters provided in the input file from the DHSVM website. 

The model of the watershed with drainage tiles was calibrated to WY2009 stream discharge. 

The calibration was improved by adjusting soil properties. Adjustments to basin properties 

were guided by an understanding of watershed conditions from previous studies, and field 

data and geomorphic mapping that I performed. After multiple attempts, a successful 

calibrated and validated model was created (Figure 20).  

My first calibrations were performed with a soil depth of 1.5 to 3 meters. Initial calibrations 

resulted in erroneously high base flows that were sustained through the summer months 

when the channel is typically dry. Changes to conductivity, maximum infiltration, porosity 

and field capacity were made in an effort to improve the calibration. Vertical conductivity 

was increased and lateral conductivity was decreased by order magnitudes in an attempt to 

lower the amount of channel water contributions. Field capacity and porosity were both 

increased to increase soil storativity thereby reducing the water movement to the channel. 

These adjustments resulted in an acceptable discharge for the calibration period. However, I 
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was unable to validate the model. When an additional years’ worth of precipitation was 

added to the model during validation, acute increases in baseflow would occur.  

It was determined that inadequate storativity, a result attributed to shallow soil depth, was 

causing a rapid rise in the water table, intercepting the stream channel. Therefore, the soil 

depth was modified with several versions being tried. A soil depth of 15 to 30 meters was too 

deep. It required many years of meteorological data to create accurate initial conditions. 

Additionally, with very thick soils make it is difficult to simulate the lower conductivity lens 

located near the soil surface in the basin. A soil depth of 3 to 6 meters was used, but this was 

not thick enough and similar problems occurred with an acute increase in baseflow after 

several years.  

A soil depth of 5 to 15 meters thick produced good results, sufficiently thick enough for 

adequate storativity however thin enough to simulate the finer soil details and reasonably 

create the initial conditions. The water table would steadily increase each progressive year, 

however the increase was much slower taking multiple years before any significant influence 

on discharge was observed. This allowed for runoff to be mimicked for a couple years before 

groundwater table would raise enough to influence stream baseflow.  

With the soil depth corrected, values for soil parameters were adjusted to reflect know 

conditions with the watershed (Table 7). Of the five soils classes located within the basin, 

only soil parameters for soils 4 and 17, silty-loam and muck, were adjusted. The soil 

parameters for the remaining soils, soil 2, 3 and 6 (loamy sand, sandy loam and loam) were 

the same as the default values provided in the original DHSVM input file. The decision to 

make adjustments to only soils 4 and 17 was a result of the drainage tile network being 
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largely located with these two soils, suggestive of a distinctive hydrologic regime. This was 

reinforced by analysis of geomorphology, soil surveys and field observations indicating a 

lower conductivity lens approximately 1-meter below ground surface. Field capacity, 

porosity and pore size distribution in soil 4 and 17 in the bottom two soil layers were 

adjusted to reflect the dense compact nature of the low conductivity layer.  

Qualitative comparison between the observed and predicted hydrographs for the calibrated 

basin with drainage tiles indicates good agreement between low and peak flows and the 

shape of the accumulation and recession curves. Although summer discharge was very low in 

the predicted basin, discharge did not drop to zero as with the observed basin hydrograph.  

Validation 

Validation is performed to determine the predictive ability of the calibrated model for a time 

series outside the calibration period. The validation period was October 1, 2009 to May 1, 

2010. Typically, the validation period is one-year or greater, however due to equipment 

malfunction, stream discharge data was only available for part of WY2010.  

Weather for both the calibration and validation period were similar; precipitation was slightly 

lower for the same period in WY2010 than in WY2009 and that winter temperatures were 

significantly warmer in WY2010 compared to WY2009.  

First order assessment of the validation was a qualitative comparison of observed and 

predicted hydrographs, assessing the agreement between base, low and peak flows and the 

shape of the accumulation and recession curves (Figure 21). In general, there was good 

agreement between the shape, frequency and magnitude of base and event flows during the 

observed and predicted validation time series. Between October 1, 2009 and December 7, 
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2009, the predicted base and peak flows are over estimated. For the period following 

December 11, 2009, a reversal occurs and predicted base and peak flows are generally 

underestimated. The period between December 7 and 11, 2009 is associated with observed 

discharge data that was identified as suspect. It is unclear whether the reversal in the 

predicted values is a product of error in observed measurements. Regardless, the differences 

are determined to be insignificant. 

Quantitative assessment was determined by using a series of established statistical analysis, 

which include coefficient of determination (r2), Nash-Sutcliffe efficiency with logarithmic 

values (ln E), and comparison of total annual discharge (Krause et al., 2005). The coefficient 

of determination for the validation period was 0.39 and for the entire period of record, which 

is both calibration and validation time series, was 0.53. The Nash-Sutcliffe efficiency using 

logarithmic values reduces the influence of extreme values compared with other efficiency 

criteria that employee square difference. The ln E value was 0.36 for the validation period 

and 0.41 for the entire period of record. The difference between total annual discharge was 

3,750 m3 or 6 percent for the validation period and the difference for the entire period of 

record was 11,990 m3 or 9 percent.  

I determined from qualitative and quantitative assessment of the validation time series that 

the DHSVM model of Ebey’s Prairie is successfully validated. 

5.1.5 DHSVM Simulations 

Watershed Scale Analysis of Drainage Tiles 

The influence of drainage tiles on watershed hydrology was quantified by comparing 

DHSVM hydrologic outputs between two modeled basins, one representing the Ebey’s 
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Prairie watershed with drainage tiles and one representing the watershed without drainage 

tiles. To simulate the basin without agricultural drainage tiles, a modified DEM grid and 

stream network were used. Otherwise all other grids were identical to grids used with the 

calibrated basin with drainage tiles. Soil properties values established during calibration were 

used for both basins (Table 7).  

Ten simulations representing WY2001 to WY2010 were completed for each basin (Figure 

22-24). Each simulation lasted two years, the first year was to establish initial conditions in 

the basin and the second year was for data analysis. Multi-year simulations were not run. 

When multi-year simulations are run, there is a small but progressive increase in the water 

table, attributed to relatively shallow soil thickness used in the model. To remain consistent 

with calibration and validation procedures, the length of all simulations were kept uniform.   

Analysis of the hydrographs for each basin reveals some general trends (Figure 25). The 

general shapes of the hydrographs are similar for both watersheds; however discharge from 

the basin with tiles is almost always larger.  Both basins have similar response rates to an 

event, although peak discharges are significantly larger in the basin with tiles. Additionally 

base flows for both basins are near zero during the summer.  

Average annual discharge for the basin with drainage tiles is 163 percent higher than the 

basin without tiles (Table 8). The difference in volume averaged 41,540 m3 (10.97 M gal.) 

per year; or if equally distributed across the entire watershed, a depth of 3.35 mm (0.13 in). 

Average hourly discharge is 262 percent higher in the basin with tiles compared to the basin 

without tiles, 7.65 m3/hr (0.08 cfs) and 2.91 m3/hr (0.03 cfs) respectively. Maximum and 
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minimum hourly discharge was also higher for the basin with tiles, at 192% and 262% 

respectively.  

Average annual ET for both watershed‘s, with and without tiles present, was approximately 

61 percent (Table 9). This is similar to previous studies for Whidbey Island (Cline, 1982). 

Average ET rose slightly by 0.038 mm when drainage tiles were present, or an insignificant 

increase of 0.007 percent increase. 

Potential aquifer recharge was calculated for Ebey’s Prairie watershed for water years 2001 

thru 2010 (Table 9).  Potential recharge represents all water held in the soil column with 

excess water delivered to the aquifer for recharge. Recharge was estimated by subtracting 

DHSVM provided evapotranspiration (ET) and stream discharge from precipitation. 

Precipitation and ET values provided by DHSVM are as single values, representing a basin 

wide average. Discharge values were divided by the watershed area (12,416,700 m2), thereby 

converting discharge units from cubic meters to meters.  

Annual recharge for the watershed with tiles averaged approximately 2.47 M m3 (19.9 

cm/yr.), with a range of 1.18 to 3.41 M m3 (9.5-27.4 cm/yr.). Annual recharge for the 

watershed without tiles averaged approximately 2.51 M m3 (20.3 cm/yr.), with a range of 

1.21 to 3.46 M m3 (9.7-27.9 cm/yr.). The difference in recharge ranged between 27,020 to 

50,510 m3 (0.2-0.4 cm/yr.), with an average of 41,420 m3 (0.3 cm/yr.). The difference 

represents an average 1.65 percent decrease in total watershed recharge when drainage tiles 

are present, with a range of 1.42 to 2.40 percent during the ten-year simulation period.  

There is also a correlation (r2=0.80) between precipitation and the difference in recharge 

between the two basins. In general, the years with the least precipitation have the least 
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difference in recharge between the two basins, and in years with greater precipitation the 

opposite is true. 

Analysis of Drainage Tiles by Soil Class 

The hydrologic response within the watershed varies depending on soil type. The influence 

of drainage tiles on individual soil classes within the watershed was measured by comparing 

DHSVM outputs from individual pixels from each soil class. Ideally, all pixels representing a 

single soil class would be averaged for analysis; however this is not easily done within 

DHSVM. DHSVM outputs from five pixels representing three soil types (sandy loam, loam 

and silty loam) were analyzed for water years 2001-2010 (Figure 26). The additional two 

pixels were from the silty loam soil class; they were chosen to measure variations within a 

soil type resulting from notable topographic features, namely closed depressions observed in 

LiDAR imagery. 

 It is important to note that the DHSVM model was calibrated and validated as an entire 

watershed; with heterogeneities within the soil being averaged across the entire watershed. 

Therefore, pixel by pixel analysis is prone to much greater error and is only used for 

identifying trends as opposed to quantifying absolute values.  

A comparison between soil classes reveals some general trends (Table 10). Average soil 

moisture in the upper most layer (surface to ~5 m) is greatest in the silty loam, followed by 

the loam and sandy loam respectively. Runoff was observed only in the silty loam; no runoff 

was observed in either the loam or sandy loam. Potential recharge is greatest in the sandy 

loam, followed by the loam and silty loam respectively. Potential recharge calculations for 

the silty loam resulted in negative values indicating that more water is leaving the pixel than 
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entered from direct precipitation; this is being driven by large runoff values. Note that the ET 

values for all five pixels is lower than the basin average of 32.4 cm, a product of landcover 

types not represented by these pixels. 

The hydrologic response to drainage tiles provided a few general trends (Table 10). For both 

sandy loam and loam, there was no change observed in DHSVM outputs between basins with 

and without drainage tiles. The only measurable changes were observed in the silty loam, 

with the largest changes occurring with runoff and subsequently recharge.  

Within the silty loam soil, the closed basins had higher soil moisture in the upper most layer 

compared with other locations (28 and 26 percent respectively). In addition, the saturated 

flow was zero for both pixels within the closed basins, where other locations observed 

significant saturated flow. 

5.2 Geomorphic Mapping 

A complete geomorphic map was created for Ebey’s Landing National Historical Reserve 

(Figure 27). A total of 20 distinct landforms were identified in the map area covering an area 

of 72.71 km2 (Table 11). The majority of the map area (86 percent) is composed of four map 

units: glaciated uplands, ice marginal deltas, marine terrace and kame kettle units. Ebey’s 

Prairie is a marine terrace with dunes located along its southwest margin.  

Landform boundaries were based on changes in topography and depositional composition of 

the landform. When appropriate, boundaries mirrored EBLA geologic map units defined by 

Polenz (2004). When applicable, landform types were based on a NPS geomorphic map units 

used at other NPS units in Washington State. However, only two units of the 20 identified at 

EBLA were present in the NPS landform database. The remaining 18 landform types are 
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unique to EBLA. New units were based on definitions provided by the USDA National Soil 

Information System (NASIS) and from discussions with the Jon Riedel, Geologist for the 

NPS. Definitions for the landforms are provided in Appendix 2. 

LiDAR analysis revealed two significant depressions, or closed basins, located near the 

existing marsh in Ebey’s Prairie (Figure 28). The boundaries of the closed basins were 

interpreted to be shorelines of relict marsh areas. Interpretation is based on the general 

morphology of the features, in addition to the close proximity of the existing marsh. The 

closed basins are located with the USDA soil Coupeville Silt Loam, 0-2 percent slopes, 

which is described as the water table being near the surface during the winter and it dries out 

later in the spring than the Coupeville Loam, 0-3 percent slopes. The drainage tile network 

also is coincident with the closed basins.  

5.3 Sediment Core Analysis 

Two sediment cores were successfully collected from separate locations (Figure 29). The 

first core (core ID: LP-08-01) was collected on July 25, 2008 from the deepest part of Lake 

Pondilla (5.8 m). The 6.64 meter long core was extracted in 7 pushes using a team of three 

workers. I was unable to core deeper because the depth of deposits exceeded the capabilities 

of the available equipment; additional extension rods and core barrels were unavailable to 

continue coring.  

A second core (LPB-09-01/02) was collected on January 8, 2009 in the adjoining bog located 

east of the lake. The site was chosen to permit greater depth in coring, in the absence of the 

5.8 m deep lake. Although lacustrine locations are preferred, the bog was part of the same 

kettle as Lake Pondilla and likely shared a similar depositional history. A 9.24 m long core 
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was successfully extracted from the Lake Pondilla bog in 13 pushes using a team of three 

workers. While conducting the 8th push of LPB-09-01, equipment malfunction resulted in 

loss of the core barrel. The core was continued (LPB-09-02), starting adjacent to the LPB-09-

01 core hole, with the first push of LPB-09-02 beginning above the last successful push of 

LPB-09-01, thereby creating 55 cm of core overlap (combined push lengths were 9.79 m). 

Regardless, I unable to core to the intended contact because the depth of deposits were 

greater than I were able to core. Coring at depths over 10 meters greatly increases the 

likelihood of not being able retrieve the equipment from the core hole.  

A goal of this project was to collect and analyze a core that contained all sediments deposited 

in the kettle since it was formed, this did not occur. Analyses of the two cores are described 

in the following sub-sections. No material was collected for radiometric dating that 

constrains the time of kettle formation because I was unable reach the intended contact.  

5.3.1 Stratigraphic Analysis 

Core LP-08-01 

The core is primarily composed of large amounts of peat and plant matter mixed with fine 

organic mud. The core is divided into two units: (1) organic mud, and (2) peat. In addition, a 

single fine sand layer and single charcoal layer occur in the core. The organic mud unit is 

composed of organic mud and partially decomposed plant material; it is medium to very 

thick-bedded (Figure 30). The peat unit is thin to medium bedded. It is composed of poorly 

decomposed plant matter, with large diameter roots (1 mm). 

Organic mud extends from the top of the core to 346 cm. Between 346 and 417 cm deposits 

alternate between medium bedded strata of peat and organic mud. From 417 to 567 cm, a 
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thick bedded organic mud unit occurs, below which are two medium bedded peat and organic 

mud strata. From 598 cm to 664 cm, the bottom of the core, is a medium bedded peat.  

The fine sand layer is a very thinly bedded, very dark gray stratum located between 597 and 

598 cm (Figure 32). The stratum is composed of mature well-sorted fine grain sand. The sand 

was composed of equant, rounded quartz grains (Figure 33). Directly below the fine sand 

layer is a thinly laminated to laminated bed of charcoal. 

The color of the core sediments are mostly independent of unit type (except for the fine sand 

unit), in the upper 2 meters the sediments are very dark brown (HUE 10YR 2/2) and then 

graded to a dark reddish brown (HUE 5YR 3/4). 

Additionally, no tephras were identified in the core. 

Core LPB-09-01/02 

Core LPB-09-01/02 is primarily composed of peat. Two lighter colored clastic mud and peat 

layers and a tephra stratum are also observed in the core.   The peat unit is nearly continuous 

from the top of the core to the bottom, 0-924 cm. The peat color largely varies between a 

dark brown (HUE 10YR 2/2) and a very dark brown, nearly black (HUE 10YR 2/1; Figure 

34). There was no correlation observed between peat color and changes in MS or LOI. 

The peat and mud unit strata are thin to medium bedded located at 267-274 cm and 294-305 

cm. The color of the unit is a light chalky brown (HUE 10YR 3/2; Figure 35).  

A tephra occurs at 781-782 cm. The tephra is a light beige color (HUE 2.5YR 6/3; Figure 

36). Tephra grain size ranges between clay and silt.  
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A light colored deposit occurs between 888 and 894 cm. The deposit  is located at the top of 

a push, it is irregularly shaped and not continuous layer, and its color is identical to the tephra 

stratum; therefore, it is determined to be material scraped from the side of the core hole while 

re-inserting the core barrel between pushes. 

5.3.2 Magnetic Susceptibility 

Core LP-08-01 

Magnetic susceptibility in core LP-08-01 averaged 13.8 x 10-5 SI, with a high of 83.0 x 10-5 

SI and a low of -0.2 x 10-5 SI (Figure 37). There were several noteworthy troughs and peaks 

within the core. The lowest magnetic susceptibility values were located in the deepest 

deposits from 596 to 664 cm, with a low of -0.2 x 10-5 SI at 624 cm. The highest 

susceptibility values in the core occurred between 474 and 592 cm, which contained 7 peaks 

with alternating lows. The greatest magnetic susceptibility value was 83.0 x 10-5 SI, which 

occurred at 534 cm. Other sample locations with elevated values were at 8, 194, 316 and 380 

cm. No tephras were identified within the LP-08-01 core.  

Core LPB-09-01/02 

Magnetic susceptibility in core LPB-09-01/02 averaged 0.9 x 10-5 SI, with a high of 6.9 x 10-5 

SI and a low of -1.4 x 10-5 SI (Figure 38). The core had an overall trend of relatively low MS 

values higher in the core and higher MS lower in the core. From 0 to 605 cm, MS values 

fluctuated between 1.0 x 10-5 SI and -1.0 x 10-5 SI with a few peaks extending modestly 

beyond this range, with a high of 2.5 x 10-5 SI and low of -1.3 x 10-5 SI. From 621 to 924 cm, 

MS increases with depth to a maximum of 6.9 x 10-5 SI at 913 cm. There were two 

noteworthy susceptibility peaks, along with several smaller peaks. A peak at 781 cm of 6.8 x 
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10-5 SI is associated with a tephra. A second peak of 6.9 x 10-5 SI occurs from 905-913 cm. 

Several smaller MS peaks with values ranging from 2.7 x 10-5 SI to 4.7 x 10-5 SI occur 

between 627-891 cm. Additionally, MS values associated with the peat-mud units averaged 

0.45 x 10-5 SI and were greater than surrounding peat strata, which averaged  -0.20 x 10-5 SI. 

There was no clear relationship between peat color and associated MS values.  

There is an order of magnitude difference in MS values between cores LP-08-01 and LPB-

09-01/02. The difference probably reflects the higher saltwater content in the sediments in 

core LP-08-01 as suggested by the sulfurous odor noted during core extraction and the closer 

proximity to coast.  

5.3.3 Loss on Ignition 

Core LP-08-01 

Seventy-three samples were extracted from core LP-08-01 for loss on ignition analysis. The 

resulting organic content values averaged 48.0 percent for the entire core, with a high organic 

content of 68.2 percent and a low of 4.2 percent (Figure 37). There appears to be a significant 

inverse relationship between magnetic susceptibility and the percent organic content. 

However, the location with the lowest percent of organic content (4.24% at 597 cm) did not 

correspond to the highest magnetic susceptibility (534 cm). Similarly, the highest organic 

content sediments did not correspond to the lowest magnetic susceptibility.  

Core LPB-09-01/02 

One hundred and four samples collected from core LPB-09-01/02 for loss on ignition 

analysis. Organic content values averaged 66.0 percent for the entire core, with a high 

organic content of 97.0 percent and a low of 7.0 percent (Figure 38). Again, there appeared to 
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be a strong inverse relationship between magnetic susceptibility and the percent organic 

content. From 0 to 605 cm, where MS values were generally the lowest, the average organic 

content was 78 percent. From 621 to 924, where MS values were generally the highest, the 

average organic content was 40 percent. Organic content of the single identifiable tephra lens 

was 6.5 percent. The organic content associated with the MS peak at 905-913 cm was 14 

percent. Additionally, the organic content associated with the peat-mud unit was lower than 

the surrounding peat strata.  Organic content associated with the peat-mud units averaged 

64.0 percent and were elevated relative to surrounding peat strata average of 76.4 percent. 

There is not clear relationship between peat color and associated LOI values. 

5.3.4 Tephra Identification 

A thin tephra stratum was identified in the core at 781-782 cm. Tephra from Mount Mazama 

is the most likely found in Holocene lowland lakes in the Puget lowland (D. Clark 2011, 

personal comm.). The climatic eruption of Mount Mazama is dated ~7,700 cal. yr. B.P. 

(6845+50 14C years B.P.; Bacon, 1983). A sample was collected and analysis of mineral was 

analyzed for chemical composition using the SEM/EDS (Figure 39). Results were compared 

to reference Mazama tephra #30 in the tephra identification database, GeoAnalytical 

Laboratory, WSU. Chemical analysis was inconclusive; although there were similarities in 

the chemical composition between the collected and reference samples, mineral constituents 

were outside expected ranges. Geochemistry of the unknown tephra and reference tephras are 

listed in Table 12.   
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6.0 DISCUSSION 

6.1 Comparison with Previous Studies 

The results collected from field measurements and hydrologic modeling from this study are 

supported by similar results from previous studies. Previous research by Sumioka and Bauer 

(2004), Sapik et al. (1988), and Cline et al. (1982) have measured stream discharge and 

modeled aquifer recharge in nearby basins and for Whidbey Island. A comparison of 

discharge and recharge values, as well as hydrologic regimes, between this study and 

previous studies follow. 

6.1.1 Stream Discharge and Evapotranspiration   

Sumioka and Bauer (2004) measured discharge for a stream that drained into northern Penn 

Cove (station 12170320, here after Penn Cove basin). The basin area is nearly one-fifth the 

size of Ebey’s Prairie basin (2.51 km2 and 12.4 km2, respectively). However, the total 

discharge for Penn Cove basin was 426 percent greater than Ebey’s Prairie basin without 

drainage tiles and 162 percent higher than Ebey’s Prairie basin with drainage tiles (108,800 

m3 compared to 25,512 m3 and 67,053 m3 respectively2). Sumioka and Bauer do not mention 

the presence or absence of drainage tiles in the basin. Similar differences are found in mean 

discharge, maximum discharge and percent of total precipitation between the two basins.  

When compared against basin size, discharge is unexpectedly larger for the stream in Penn 

Cove basin versus the Ebey’s Prairie stream. However, there is uncertainty regarding basin 

size delineation; the difference in size maybe attributed to different methods used for basin 

delineation, computer-generated versus user-defined (S. Sumioka 2011, personal comm.). 

                                                           
2
 Average annual discharge was calculated for Sumioka and Bauer. (2004) by multiplying provided runoff (1.70 

in) by basin size (0.97 mi
2
) 
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The lower discharge of Ebey’s Prairie stream may indicate a smaller effective basin area 

contributing to discharge, rather than larger. Analysis of DHSVM model data suggests the 

large majority of saturated flow and runoff is associated with the silty loam soil class. The 

silty loam has an area one-sixth that the Penn Cove basin; if the effective drainage area was 

limited to the silty loam soil, it would have a similar area-to-discharge ratio as the Penn Cove 

basin.  

The differences in discharge may also be related to the steeper basin slopes in the Penn Cove 

basin, which would increase lateral flow. Slopes of Ebey’s Prairie are largely between 5 - 15 

degrees compared to10 - 30 degrees for the Penn cove basin. Regardless, both streams are 

relatively small, which is in agreement with Anderson’s (1968) view that relatively low 

stream discharge and poorly developed stream networks are shared characteristics of 

Whidbey Island streams, a result of small basin sizes and low precipitation. 

Analysis of the hydrographs for this study revealed a similar response to rainfall events in 

simulations with and without drainage tiles. In general, however, the basin with tiles had 

larger peak values, greater hourly baseflows and a longer recessional curve (Figure 25). Peak 

flows were generally 2 to 3 times larger when drainage tiles were present; the results are in 

agreement with O’Kelly (1955) and Baily and Bree (1980). The increase in peak flows may 

be due to a larger effective drainage area for the stream when drainage tiles are present, 

which would deliver runoff to the stream that otherwise, would be held in the soil or go to 

recharge. However, both O’Kelly and Baily and Bree also noted an increase in time-to-peak 

in drained basins, which was not observed in this study. The larger recessional curve 

indicated when drainage tiles are present is consistent with results from Deboer and Johnson 

(1969) and Skaggs (1982).  
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Robinson (1980) noted an individual stream’s response when drainage was increased was 

associated with soil type and rainfall regime. According to Robinson, peak flows would 

increase in higher permeability soils with lower overland flow. The results from this study 

are in agreement with Robinson. The soils containing drainage tiles in Ebey’s Prairie are silty 

loams overlying clay. The drainage tiles are effectively draining water from higher 

permeability loam that is perched on top of lower permeability clay layer. The relationship 

between rainfall intensity and response to drainage observed by Robinson (1980) and Hann 

and Johnson (1968), was also observed in this study. Ebey’s Prairie, which receives largely 

low-intensity moderate-frequency rainfall, had increased peak flows when drainage tiles 

were added.  

Whiteley (1979) stated that draining water in depressions, that otherwise would be lost to 

evapotranspiration or deep percolation, increases the peak flows.  By extending drainage tiles 

into the two closed basins, the effective drainage area of Ebey’s stream was increased and the 

travel time for the water decreased, which resulted in increases to peak and baseflows. 

Decreases in time-to-peak and peak flows resulting from lower soil moisture due to drainage 

tiles were not observed in the hydrographs as noted Maddock (1954) and Weir (1949).  

Whiteley (1979) stated that total evapotranspiration decreases when drainage tiles are 

present, a result of lower soil moisture. Ebey’s Prairie watershed did observe a small 

decrease in ET when tiles were present; however it was sufficiently small to be within the 

bounds of error of the model and therefore insignificant. No clear trend was observed at the 

pixel scale for individual soil classes. 
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6.1.2 Potential Recharge  

The potential recharge calculated for Ebey’s Prairie watershed is similar to values determined 

by other studies. Average recharge for Ebey’s Prairie with drainage tiles is 19.92 cm/yr. and 

without drainage tiles was 20.25 cm/yr. (37.7% and 38.3 % of total rainfall respectively). 

Sumioka and Bauer (2004) estimated recharge for all Whidbey Island at 14.50 cm/ yr. (28% 

of total rainfall). However, for the two dominant soil types within Ebey’s Prairie watershed, 

Sumioka and Bauer calculated recharge as 0 to 10.16 cm/yr. (0-20% of rainfall) for loam and 

10.16 to 20.32 cm/yr. (20-39% of rainfall) for the deltas. The recharge values from this study 

are greater than average calculated by Sumioka and Bauer (2004) for Whidbey Island, but 

within the range for soils calculated in Ebey’s Prairie watershed. Additionally, this study 

calculated potential recharge, rather than actual recharge, and therefore estimates maybe 

larger than actual. Recharge rates calculated from other studies are similar to my estimates. 

Recharge estimated for Whidbey Island by Cline et al. (1982) was 12.45 cm/yr. and by Sapik 

et al. (1988) was 24.99 cm/yr.  

The average annual discharge is 41,540 m3 (10.97 M gal.) greater in drained versus 

undrained Ebey’s watershed. Most of the additional discharge (41,420 m3) infiltrates as 

potential recharge, with the remaining being lost to ET. Island County estimated average 

water use at 90 gallons per day per person, with a peak of 250 gallons per day per person. 

Based on these estimates, the difference in potential recharge is equal to one year’s water use 

for between 120 to 333 people.  

Analysis of DHSVM model data and interpretation of USDA soil descriptions, and recharge 

rates for watershed soils from Sumioka and Bauer (2004) suggest that the sandy loam soils 

located in the watershed contribute little to discharge in Ebey’s Prairie stream. The sandy 
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loam composes a large portion of the watershed area, as delineated by DHSVM. Analysis by 

soil class using DHSVM suggests the large majority of saturated flow and runoff is 

associated with the silty loam soil class. Interpretations of the USDA soil descriptions 

suggest most of the difference in discharge and subsequently recharge is being driven by the 

loam and silty loam, noting that these two soils are largely saturated in the winter and are in 

need of “additional drainage”. Therefore, most changes to potential recharge when drainage 

tiles are present are occurring within either the silty loam and loam soils or just the silty loam 

soil. This is important because the change in potential recharge between the two basins 

constitutes only 1.65 percent of the total recharge for the watershed, which is within the 

margin of error for the model.  However, when placed in the context of effective drainage 

area, their impact on discharge and recharge becomes more significant. Distribution of an 

additional 41,420 m3 of recharge across the entire watershed (as delineated using DHSVM) 

results in an increase in recharge of 0.4 cm/yr. However, if the additional recharge is 

distributed across the silty loam and loam only, it would result in an increase of 1.0 cm/yr.; 

and if distributed across the silty loam soil only, it would result in an increase of 9.8 cm/yr.  

Sumioka and Bauer (2004) note that because estimating recharge cannot be done directly, 

estimates are subject to large errors. The estimates from this study are for potential recharge 

and it is unclear what percentage of potential recharge will reach the sea-level aquifer and 

what percentage discharges through submarine springs. 

6.3 Model Uncertainty 

There are likely several sources of error that may influence the results of the hydrologic 

modeling. Although I was unable to quantify the magnitude of error, potential sources 
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warrant discussion. Following is a discussion on the potential sources of error, including 

error associated with basin set-up and field data collection 

6.3.1 DHSVM Basin Set-up  

The DHSVM model was developed at the University of Washington for modeling surface 

water in mountainous watershed in Pacific Northwest environments. Ebey’s Prairie 

watershed is located in the low relief coastal environment of the Puget Lowlands. There is no 

published material applying the DHSVM model to lowland watersheds and this distinction 

has several implications.  

DHSVM uses algorithms to calculate soil thickness based on slope and user defined limits, 

the soil thickness is then divided into three layers of equal thickness and soil properties can 

be adjusted independently for each layer. Grid cells exchange water both vertically and 

horizontally with neighboring cells. Vertical water movement is limited by the lowest soil 

layers, soil layer 3; at which point the water moves only horizontally until it intercepts a 

stream channel. In relatively shallow soils on top of large impervious bedrock, similar to 

what is found in mountainous watersheds, this method is adequate to represent water 

movement and soil heterogeneities through the soil column. However, in soils on top of a 

thick layer of unconsolidated material, similar to what is found on Whidbey Island and 

Ebey’s Prairie, it is less than ideal.   

Unconsolidated material allows vertical water movement and needs to be accounted for in 

the model, otherwise soil moisture and groundwater will be misrepresented. However by 

accounting for the added water storage capacity by increasing soil thickness a number of 

secondary issues arise. For example, in Ebey’s Prairie watershed thickness of soil and 
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unconsolidated sediments are greater than 30 m. When a 30 m soil thickness was used, it was 

difficult to accurately represent conditions like a higher conductivity surface layer on top of a 

shallow till layer. In this example using a 30 m soil, the surface layer would be 10 meters 

thick and the shallow till layer would begin at 20 m. If a shallower soil thickness was used 

soil moisture would erroneously increase and eventually the water table would rise above the 

stream channel. To account for this, in the Ebey’s Prairie watershed, I used a soil thickness 

sufficiently deep and storage capacity large enough to accommodate more than 2 years’ 

worth of precipitation input before groundwater interfaced with the stream channel. This was 

resolved by running simulations for 2-year periods, which included one-year for initial 

conditions. However, what is lost is the influence of consecutive years of weather on the 

watershed. The cumulative impact of simulations of multiple years may be more influential 

in landscapes with large subsurface storage capacities, like Ebey’s Prairie.  

Watershed boundaries are defined using topographic data from a DEM. In mountainous 

watersheds, topography is reliable determiner of boundaries; typical landforms associated 

with basin boundaries are bedrock ridges and significant relief exists between valley floors 

and surrounding ridges. Central Whidbey Island is starkly different, with maximum relief of 

approximately 100 meters and with no bedrock exposed above sea-level, watershed divides 

are composed of unconsolidated sediments. By determining watershed boundaries from 

topography, the DHSVM algorithms are biased towards surface features that may not be 

related to water movement and overlooks subsurface features that maybe driving water 

movement. In the case of Ebey’s Prairie watershed, the western margin of the watershed 

delineated by DHSVM appears to be influenced by relict outwash stream channels on the 

Smith Prairie delta, while disregarding the subsurface stratigraphy of the delta’s foreset beds 
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that slope towards Ebey’s Prairie. Similarly on the eastern margin of the watershed, the Penn 

Cove delta is largely outside the watershed, again disregarding the delta’s foreset beds that 

slope west towards Ebey’s Prairie. However, water movement in the course well-drained 

soils that compose the deltas near Ebey’s Prairie is predominately vertical. The use of GIS 

software for calculating watershed boundaries does allow for manipulation and future studies 

in watersheds dominated by unconsolidated sediment may consider additional checks.  

The algorithms used by DHSVM to calculate the stream network is based on topography data 

from the DEM. Similar to the watershed boundaries calculations, the stream network 

calculations can be erroneously influenced by surface topography. In the case of Ebey’s 

Prairie, the relict outwash channels on the Smith Prairie delta were included in both stream 

networks for the basin with tiles and without tiles. DHSVM allows for deleting erroneous 

streams segments, which was done. However, deletion was based on interpretation of local 

LiDAR data; no field visits were performed to inform these decisions.  

Creation of stream network representing the drainage tile network was based on a GIS layer 

of drainage tile locations provided by Island County and constrained by attributes of the 

DHSVM model. The location and extent of drainage tile presented in the GIS layer was 

checked through interviews with local landowners, however many of these tiles were 

installed 60 or more years ago. Many of the current landowners recollections are based on 

information passed on from the earlier generations who installed the tiles. 

Additionally, the DHSVM model does not allow for stream networks to be losing streams, 

once surface and subsurface water intersects with a segment of the stream network it is does 
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not return the soil. The actual structure of the drainage tiles, as well as Ebey’s Stream, is such 

that it allows water to exchange between the soil and the channel. 

There was no spatial data available delineating the historic (pre-drainage tiles) surface water 

and stream network within Ebey’s Prairie. The historic network was based on surface 

features interpreted from LiDAR. It was interpreted that the two closed basins and the 

modern marsh were at least seasonal marshes prior to drainage tile installation and that a 

stream connected these features.  

6.3.2 Field Data Collection 

Missing data and erroneous values in the stream stage data, point discharge measurements 

and the calculated rating curve may be sources of error. The pressure transducer had periods 

of missing data and periods of suspect data when negative values were recorded. Sixteen 

discharge measurements were collected although none were taken at peak flows. The rating 

curve created from the stage discharge data did not have a high coefficient of determination 

value; as a result some values are likely skewed by the application of the rating curve. Using 

a rating curve with a low r2 value decreases the reliability of both model calibration and 

validation.  Sumioka and Bauer (2004) suggest that the accuracy of the best discharge data is 

within 5 percent and they estimated their accuracy of stream discharge to be 10 percent, due 

to the small size of the streams.  

Missing data and erroneous values from the weather data may be a source of error. Data from 

multiple stations were used. Data from the nearest station was used when possible; however 

the closest stations were still located a distance of between approximately 16 and 55 km from 

Ebey’s Prairie. Comparison of data between sites located within the watershed and sites 
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located outside the watershed showed good agreement between most parameters. The two 

parameters with the notable difference were precipitation and wind speed. Coupeville COOP 

daily precipitation values were disaggregated to hourly values based on a correction factor 

calculated from stations outside the watershed. Any error associated with this is likely small, 

possibly only affecting peak flows. No reliable wind speed data was available from stations 

within the watershed. Comparison between available watershed data and nearby stations 

indicated average winds at the NAS site were significantly higher and although average 

winds at the WSU-Mt. Vernon site were significantly lower, they were closer to reliable 

values from watershed data from the WSU-Whidbey site.  

6.4 Relating Geomorphology to Hydrology 

Ebey’s Prairie watershed recharge ranged from 0-31 cm/yr depending on location, as 

illustrated by Sumioka and Bauer (2004). The drivers of the difference in recharge are the 

landforms and the composition of underlying soils. This can be observed when comparing 

landforms identified from this study and others with soil descriptions from the USDA Soil 

Survey (1968) and Sumioka and Bauer (2004) estimates. The soils composing the dunes and 

deltas are described as having rapid drainage and high recharge (dunes: 20-31 cm/yr.; deltas 

10-31 cm/yr.), a result of the porous sand and gravel composition. Whereas, the soils 

composing the marine bench in Ebey’s Prairie contain a low-conductivity clay layer; capped 

largely by a loam or silty loam of varying thickness. These soils are prone to high soil 

moisture during the winter, that dry out late in the summer. As a result, most drainage tiles in 

the watershed are located on the marine bench, draining water perched on top on low 

conductivity soils in shallow closed depressions. The glacial origin of Whidbey Island soils 
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makes this somewhat commonplace, as noted by the large number of small marshes and bogs 

found throughout Whidbey Island.  

There are two prominent soils that compose the marine bench, Coupeville loam and 

Coupeville silt loam. Based on soil profiles, drainage tile locations and recharge estimates, I 

believe most of the observed discharge in Ebey’s Stream is associated with these soils. The 

infiltration and recharge rates are sufficiently high for the dunes and deltas and the absence 

of a low permeability lens result in little lateral flow of water. 

The USDA Soil Survey describes both the Coupeville loam and Coupeville silt loam as 

having similar soil profiles. However, the closed basins identified as relict marshes are 

associated mainly with the Coupeville silt loam. The presence of the relict marshes suggest 

that although both soils were saturated during the winter, only the Coupeville silt loam 

contained standing water for some period. This observation is supported by soil development 

following Pleistocene glaciation. The development of the dark friable loam composing the 

Coupeville loam surface layer, as stated by the USDA soil survey, is a product of the 

grassland vegetation. However, the presence of silt in the silt loam composing the surface 

layer of the Coupeville silt loam suggests a different history. I propose the Coupeville silt 

loam contained standing water, with alternating dry periods, possibly seasonal, when 

grassland developed. This is supported by the fine silt in the Coupeville silt loam, which 

suggests standing water, in addition to the presence of the closed basins and nearby marsh in 

the same soil. 

There are several differences between the soils that would result in one soil prone to standing 

water and the other to saturated soil. First, the Coupeville silt loam has a shallower depth to 
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the confining clay layer than the Coupeville loam, which results in lower storativity in the 

soil. Second, the Coupeville silt loam resides in a lower position in the prairie than the 

Coupeville loam, with nearby soils draining laterally into the depressions. The Coupeville silt 

loam may owe its low position to a unique event. Kovanen and Slaymaker (2004) identified a 

paleo-channel of subglacial outwash from the glacier front that existed north of the 

Coupeville moraine and created the ice-contact deltas. The location of the paleo-channel 

coincides with the location of the Coupeville silt loam. Finally, well logs indicate that the 

low permeability GMD deposits near the center of the prairie, including the underneath the 

silty loam, are thicker and more continuous. GMD deposits near the delta fronts are 

interfingered with coarser deltaic deposits, potentially increasing storavity and vertical 

conductivity. 

Based on observations made during DHSVM calibration, there is only modest drainage from 

Coupeville loam into the Coupeville silt loam. Large changes to soil parameters for 

Coupeville loam resulted in only minor changes in stream discharge, this is a result of the 

nearly flat topography and the high field capacity noted in the USDA soil survey (1968).  

The installation of drainage tiles within Ebey’s Prarie appears to increase the effective 

drainage area of the Ebey’s Prairie stream, hydrologically connecting it to the closed basins. 

When drainage tiles are installed in this hydrologic regime, they move ponded and saturated 

soil water downslope. The perforated nature of the tiles permits water to drain back into the 

soil in locations with lower soil water content. During winter storm events, when all soils are 

at or near saturation, the tiles act as a conduit discharging runoff into Admiralty Inlet. 

However, as the soil dries during the spring and summer, the tiles move water from locations 

of high saturation in the silty loam to locations of lower saturation downslope. 
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6.5 Sediment Core Analysis 

A goal of this project was to collect and a core with a full depositional history and numerical 

date the earliest deposits, this did not occur. In the following section is a description of the 

paleo-environment for the period observed in each retrieved core. 

6.5.1 Core LP-08-01 

In core LP-08-01, Lake Pondilla deposits transition from older peat-dominated to younger 

clastic mud-dominated. The shift in sediments may have been driven by changes in 

environmental conditions as the climate cooled between the mid to late Holocene (Whitlock 

and Bartlein, 1997). Peat sedimentation tends to be greater in warmer shallower eutrophic 

water; reduced water temperatures from a cooling climate can slow or halt peat accumulation 

(Barber, 1981). The shift in deposition of Lake Pondilla is consistent with a cooling climate 

in the mid to late Holocene.  

Interbedded with some of the peat units are thin organic mud units, suggestive of relatively 

brief periods of fluctuating lake temperatures or water levels. Because there are no dates on 

the core, I cannot estimate the basal age or sedimentation rates.  The texture and composition 

of the well-sorted fine grain sand stratum suggests a wind-blown origin (Boggs, 2005). 

Additionally, Carlstad (1992) identified several wind-blown sand units in a nearby kettle. 

The charcoal unit is likely fire related, either natural or anthropogenic. The association 

between the sand and charcoal units is suggests a causal link, such as mobilization of clastic 

sediment, possibly by either aeolian transport or slope wash, following a forest fire. The sand 

and charcoal horizons were only identified in the Lake Pondilla core, not in the Lake Pondilla 

Bog core, suggesting a localized event.  
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I was unable to identify changes in stratigraphy related to the elevated magnetic 

susceptibility and low organic content found between 474 and 592 cm; possible causes could 

be increased clastic content from aeolian sand or increased concentration of salts from sea 

water.  

6.5.2 LPB-09-01/02 

Unlike the Lake Pondilla depsoits, the Lake Pondilla Bog deposits contain a near continuous 

accumulation of thick-bedded peat. The peat is interrupted by two beds of mud and peat, 

which could indicate changing environmental conditions, including from climate change. 

However, the thick near-continuous deposits suggest conditions stable enough for peat 

formation to occur largely uninterrupted for more than 7,700 years.  

The tephra could not be identified by comparing chemical compositions with a known tephra. 

Based on depth of occurrence, thickness, and lack of any other Holocene tephra identified in 

the region, it is likely from the Mount Mazama eruption dated at 7,700 cal. yr. B.P.(6,845+50 

14C; Bacon 1983). The tephra was located at a depth of 781 cm, assuming a 10-20 percent 

compaction rate, the estimated rate of deposition within the bog has averaged 1.1 -1.2 mm/yr. 

since the tephra was deposited (Naden 1998, Stout and Spackman 1988).  
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7.0 CONCLUSIONS 

In this study, I characterized the modern and historic surface hydrologic conditions of Ebey’s 

Prairie and its relationship to the local geomorphology. I used the Distributed Hydrology-

Soil-Vegetation Model (DHSVM) to reconstruct the pre-agricultural surface hydrology and 

quantify the effects agricultural drainage tiles have had on surface hydrologic conditions and 

aquifer recharge. A model representing Ebey’s Prairie watershed with drainage tiles and 

without drainage tiles was created and calibrated and validated to stream discharge measured 

in this study. Simulations for water years 2001-2010 for each basin condition were executed 

and compared to quantify the influence of drainage tiles on hydrologic regimes. The major 

conclusions of this study are as follows: 

The influence on drainage tiles on discharge 

 Total annual discharge was larger in the watershed with drainage tiles than the 

watershed without drainage tiles. The average volume difference was 41,540 m3, or 

an increase of 163 percent in drained basins. 

 Drainage tiles increased the magnitude of peak flow by two to three times. 

 Drained basins had greater hourly baseflow and larger recessional curves than 

undrained basins. 

 There is no significant difference in response rate to an event in either drained or 

undrained basins. 
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The influence on drainage tiles on recharge 

 Annual potential recharge for the entire watershed averaged 2.47 M m3 (19.9 cm/yr.) 

when tiles were present and 2.51 M m3 when tiles were absent, a loss of 41,4120 m3 

or 1.65 percent of a recharge when tiles were present. 

 Based on a 90-250 gallon per day per person water use estimate, the difference in 

recharge is equivalent to the annual water use for between 120 and 333 people. 

 The drainage tile network is targeting and draining primarily one soil class, silty 

loam. Most observed change between drained and undrained basins is occurring in 

the silty loam. 

 The watershed-wide impacts of drainage tiles to recharge are small and within the 

margin of error for the model. 

 The local impacts to the loam and silty loam are significant. Distribution of an 

additional 41,420 m3 of recharge across the loam and silty loam soil would result in 

an increase of 1.0 cm/yr. Distribution of an additional 41,420 m3 of recharge across 

the silty loam soil only would result in an increase of 9.8 cm/yr. 

Geomorphology and Hydrology 

 The silty loam is located in a lower position in Ebey’s Prairie, with near nearby soils 

draining laterally into the depressions. The drainage tiles are draining water perched 

on top of a low conductivity clay layer in the silty loam soil. 

 Two closed depressions located within the silty loam soil class are identified as relict 

marshes. These marshes are being drained by the tile network.  

 Installation of drainage tiles within Ebey’s Prairie is increasing the effective drainage 

area of Ebey’s Prairie stream, hydrologically connecting it to the closed basins. 
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Geomorphology of Ebey’s Landing National Historical Reserve 

 The reserve contains 20 distinct landforms covering an area of 72.7 km2. Eighty-six 

percent of the map area is composed of four map units: glaciated uplands, ice-

marginal deltas, marine terrace and kame-kettle topography. 

Sediment Core Analysis 

 Two sediment cores were collected from the Lake Pondilla kettle pond. Due to thick 

sediments I was unable to collect and date material from the intended contact between 

kettle collapse and subsequent deposition and infilling. 

 The deposits of Lake Pondilla are consistent with a changing climate in the late 

Holocene, from warmer to cooler. 

 The cores indicate a rapid sedimentation rate of 1.26 – 1.37 mm/yr.  

 A tephra was observed but could not be identified based on chemical analysis, 

however it is likely Mazama ash based on thickness and location.  
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8.0 FUTURE WORK 

Future studies using DHSVM in basins with thick unconsolidated sediments would be aided 

by a DHSVM model that allowed for individual adjustments in thickness of each soil layer 

and that water could exit the model through vertical transport out of the lowest soil layer, soil 

layer 3.  

Additional DHSVM modeling in Ebey’s Prairie could account for future land management 

projects and their impacts to surface and ground water. Coupeville is considering a number 

of options to deal with storm water runoff from the city into Penn Cove; these options 

include creating retaining ponds within the Prairie, with the closed basins described in this 

thesis. Water in the retaining ponds would then be available agricultural irrigation. Modeling 

the influence of these retaining ponds and irrigation on surface water hydrology and water 

quality, as it relates to nitrate and phosphorous transport, would be of interest.  

I was unable to constrain the timing of the kettle topography formation. Additional research 

could use equipment capable of coring depths greater than 10 meters, such as using a Mini-

Vibracore. 
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Table 1. Whidbey Island geologic and stratigraphic units, adapted from Easterbrook, 1968; Polenz et al., 2005; 
and Sapik et al., 1988. 

Geologic Climate Units Stratigraphic units 
Age   

(thousand yrs. 
before present) 

Aquifers & 
Confining 

Units 

Fraser Glaciation 

Everson Interstade 
Everson GMD 

16 
  

Partridge Gravel Aquifer E 

Vashon Stade 

Vashon Till & associated 
drift 16-20 

Confining Unit 
E 

Esperance Sand 
Aquifer D 

Olympia Interglaciation Quadra Formation 20-60 

Possession Glaciation Possession Drift 60-80 Confining Unit 
D 

Whidbey Interglaciation Whidbey Formation 80-125 
Aquifer C 

Confining Unit 
C 

Double Bluff Double Bluff Drift 125-185 ? 

 

 

Table 2. Source of meteorological data by parameter and year used for the DHSVM meteorological input file. 

 WY01 WY02 WY03 WY04 WY05 WY06 WY07 WY08 WY09 WY10 

Temperature 

NAS -----------------------------------------------------------------------------> 

(WSU-Mt. Vernon) 

WSU-Whidbey----------------------------------> 

(NAS 09/01/06-05/07/09; WSU-Mt. 

Vernon 05/08/09-09/30/10) 

Wind 

Speed 

NAS -----------------------------------------------------------------------------> 

(WSU-Mt. Vernon) 

WSU-Whidbey----------------------------------> 

(NAS 09/01/06-05/07/09; WSU-Mt. 

Vernon 05/08/09-09/30/10) 

Shortwave 

Solar Radiation 

WSU-Mt. Vernon -----------------------------------------------------------> 

(COB-Northshore) 

WSU-Whidbey----------------------------------> 

(WSU-Mt. Vernon) 

Relative 

Humidity 

WSU-Mt. Vernon -----------------------------------------------------------------------------------------------------------------------> 

(COB-Northshore) 

Precipitation 

Coupeville COOP daily scaled to WSU-Mt. Vernon hourly--------> 

(COB-Northshore) 

Coupeville COOP daily scaled to WSU-

Whidbey hourly--------------------------------> 

(WSU Mt. Vernon; COB-Northshore) 
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Table 3. DHSVM soil class distribution for Ebey’s Prairie watershed. 

Soil Class Area (Sq. km) Area (percent) 

Loamy Sand 0.80 6.45 

Sandy Loam 7.22 58.19 

Silty Loam 0.42 3.38 

Loam 3.96 31.88 

Muck 0.01 0.10 

Total 12.41 100.00 

 

 

Table 4. DHSVM landcover class distribution for Ebey’s Prairie watershed. 

Landcover class Area (sq. km) Area (percent) 

Deciduous Broadleaf 0.15 1.18 

Mixed Forest 0.56 4.49 

Closed Shrub 0.31 2.53 

Grassland 0.85 6.81 

Cropland 5.94 47.87 

Bare 0.00 0.03 

Urban 1.67 13.48 

Coastal Conifer Forest 2.93 23.61 

Total 12.42 100.00 
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Table 5. Groundwater level heights, above sea level, in late spring (maximum water level) and fall (minimum 
water level) at three wells located in Ebey’s Prairie watershed. Values in parenthesis are depth to groundwater 
in wells. Units are in meters. 

Well Identifier 

Landmark 

DFT 

Coupeville Middle School 

BFE 

Engle Farm 

363 

near Ebey’s Landing 

June 11, 2009 3.94 (34.16) 4.54 (26.85) 3.15 (24.28) 

October 23, 2009 3.94 (34.16) 4.67 (26.72) 2.97 (24.46) 

 

 

Table 6. Precipitation Comparison. Comparison of monthly and water year precipitation totals between 
WY2001 and WY2010. Source of WY2001 and WY2010 values is the DHSVM meteorological input file. 
Source of Period of record values is the National Weather Service Coupeville 1S COOP station. Units in 
millimeters (mm). 

Total 

Precipitation 

(mm) 

Oct Nov Dec Jan Feb Mar Apr May Jun Jul Aug Sep Annual 

Period of 

Record 

(1948-2005) 

46 67 70 62 45 46 41 40 32 21 23 32 525 

WY2001 28 44 37 49 37 35 59 20 47 0 10 14 380 

WY2002 88 64 58 81 29 72 26 38 19 22 3 31 531 

WY2003 20 22 58 68 33 48 76 22 2 1 6 26 382 

WY2004 43 83 50 54 31 60 5 86 23 9 65 49 557 

WY2005 46 74 64 44 26 48 48 37 60 12 37 29 525 

WY2006 45 89 88 96 53 24 71 47 27 13 3 27 584 

WY2007 55 147 74 68 38 54 21 27 39 22 14 38 597 

WY2008 40 64 83 57 40 70 53 42 55 12 36 11 563 

WY2009 26 111 86 67 35 53 42 55 7 13 12 32 539 

WY2010 101 85 34 63 29 34 58 77 48 3 20 69 623 
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Table 7. Selected DHSVM soil properties for the calibrated Ebey’s Prairie watershed.  DHSVM numerical 
identifier for each soil type in parentheses. Units for lateral conductivity, maximum infiltration and vertical 
conductivity are m/s; and for prorsity, pore size distribution and field capacity are percent of total.  

 Loamy Sand (2) Sandy Loam (3) Silty Loam (4) Loam (6) Muck (17) 

Lateral 
Conductivity 

0.01 0.01 0.01 0.01 0.01 

Maximum 
Infiltration 

6.0e-5 3e-5 3e-5 1e-5 1e-5 

Porosity 0.42/ 0.42/ 0.42 0.40/ 0.40/ 0.40 0.36/ 0.1/ 0.1 
0.43/ 0.43/ 

0.43 
0.36/ 0.1/ 0.1 

Pore Size 
Distribution 

0.35/ 0.35/ 0.35 0.21/ 0.21/ 0.21 0.26/ 0.08/ 0.08 
0.19/ 0.19/ 

0.19 
0.26/ 0.08/ 0.08 

Field Capacity 0.15/ 0.15/ 0.15 0.21/ 0.21/ 0.21 0.32/ 0.05/ 0.05 
0.29/ 0.29/ 

0.29 
0.32/ 0.05/ 0.05 

Vertical 
Conductivity 

0.01/ 0.01/ 0.01 0.01/ 0.01/ 0.01 
0.01/ 0.000001/ 

0.000001 
0.01/ 0.01/ 

0.01 

0.01/ 0.000001/ 

0.000001 

      

 



 

84 
 

 

Table 8. Comparison of predicted discharge values from Ebey’s Prairie stream with drainage tiles present and without drainage tiles present. Simulations were 
for Water year (WY) 2001 through 2010. Difference in millimeters was converted from cubic meters by dividing the cubic meter values by watershed area in 
square meters (12,416,700 m2) and then converting results to mm. 

Water 
Year 

Total Annual 
Discharge (m

3
) Volume 

Difference 
(m

3
) 

Percent 
Change 

(%) 

Difference 
(mm) 

Average Hourly 
Discharge (m

3
/hr) 

Minimum Hourly 
Discharge (m

3
/hr) 

Maximum Hourly 
Discharge (m

3
/ hr) 

Without 
Tiles 

With 
Tiles 

Without 
Tiles 

With 
Tiles 

Without 
Tiles 

With 
Tiles 

Without 
Tiles 

With 
Tiles 

2001 16,257 43,282 27,025 166 2.13 1.86 4.94 0.16 0.38 22.1 64.49 

2002 26,028 67,673 41,645 160 3.35 2.97 7.73 0.16 0.32 39.58 108.82 

2003 18,135 48,309 30,174 166 2.44 2.07 5.51 0.17 0.33 31.95 75.42 

2004 21,871 57,457 35,586 163 2.74 2.49 6.54 0.16 0.31 54.04 113.12 

2005 23,629 61,399 37,770 160 3.05 2.7 7.01 0.23 0.19 41.33 114.68 

2006 31,901 83,730 51,829 162 4.27 3.64 9.56 0.22 0.48 34 94.13 

2007 29,676 77,502 47,826 161 3.96 3.39 8.85 0.18 0.41 39.44 98.99 

2008 28,324 74,811 46,487 164 3.66 3.22 8.52 0.17 0.33 34.16 97.34 

2009 28,975 76,287 47,312 163 3.96 3.31 8.71 0.21 0.46 197.66 138.35 

2010 30,328 80,082 49,754 164 3.96 3.46 9.14 0.19 0.5 46.15 135.13 

Avg. 25,512 67,053 41,541 163 3.35 2.91 7.65 0.18 0.37 54.04 104 
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Table 9. Potential recharge for the Ebey’s Praire watershed with drainage tiles and without drainage tiles. Potential recharge is calculated by subtracting 
DHSVM outputs for evapotranspiration (ET) and discharge by total precipitation. Simulations are for water-year (WY) 2001 through 2010. DHSVM values for 
precipitation and evapotranspiration are provided in cm. DHSVM output for discharge was converted from cubic meters to cm by dividing the cubic meter values 
by watershed area in square meters, and then converting to cm. Percent values are the percentage of the specified parameter as it relates to total precipitation. 

Water Year Condition 
Total Precip. 

(cm) 
ET (cm) 

Discharge 
(cm) 

Recharge (cm) 
Difference 

(cm) 
Recharge 

Volume (m
3
)  

Volume 
Difference 

(m
3
) 

Volume 
Difference (%) 

2001 
No Tiles 38.03 28.18 0.13 9.72 

-0.22 
1,207,072 

-27,018 -2.24 
Tiles 38.03 28.18 0.35 9.5 1,180,054 

2002 
No Tiles 53.12 29.45 0.21 23.46 

-0.33 
2,912,901 

-41,445 -1.42 
Tiles 53.12 29.45 0.55 23.13 2,871,456 

2003 
No Tiles 38.24 27.91 0.15 10.18 

-0.24 
1,264,112 

-30,385 -2.4 
Tiles 38.24 27.91 0.39 9.94 1,233,727 

2004 
No Tiles 55.77 37.34 0.18 18.25 

-0.29 
2,266,655 

-36,702 -1.62 
Tiles 55.77 37.34 0.46 17.96 2,229,953 

2005 
No Tiles 52.55 33.83 0.19 18.53 

-0.3 
2,300,636 

-37,297 -1.62 
Tiles 52.55 33.82 0.49 18.23 2,263,339 

2006 
No Tiles 58.41 30.29 0.26 27.86 

-0.41 
3,459,288 

-50,507 -1.46 
Tiles 58.41 30.28 0.67 27.45 3,408,781 

2007 
No Tiles 59.75 32.59 0.24 26.92 

-0.38 
3,342,741 

-47,662 -1.43 
Tiles 59.75 32.59 0.62 26.54 3,295,079 

2008 
No Tiles 56.3 37 0.23 19.06 

-0.37 
2,367,158 

-46,118 -1.95 
Tiles 56.3 37 0.6 18.69 2,321,040 

2009 
No Tiles 53.99 28.99 0.23 24.77 

-0.38 
3,075,820 

-47,695 -1.55 
Tiles 53.99 28.99 0.61 24.39 3,028,125 

2010 
No Tiles 62.34 38.35 0.24 23.75 

-0.4 
2,948,817 

-49,355 -1.67 
Tiles 62.34 38.35 0.64 23.35 2,899,462 

Average 
No Tiles 52.85 32.39 0.21 20.25 

-0.33 
2,514,520 

-41,418 -1.65 
Tiles 52.85 32.39 0.54 19.92 2,473,102 
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Table 10. Potential recharge by soil class for Ebey’s Prairie watershed with drainage tiles and without drainage tiles. Values are averaged for water-year (WY) 
2001 through 2010.  Potential recharge is calculated by subtracting DHSVM outputs for evapotranspiration (ET), saturated flow and runoff by total precipitation. 
DHSVM values for evapotranspiration saturated flow and runoff are provided in cm. Soil moisture is presented as percent of soil volume. Negative potential 
recharge values for Silty Loam 1-3 indicate that more water left the pixel than entered it from direct precipitation, this is being driven by large runoff values. 

Soil Type 
Evapotranspiration (cm) Soil Moisture (%), Layer 1 Saturated Flow (cm) Runoff (cm) Potential Recharge (cm) 

No tiles Tiles Diff. No tiles Tiles Diff. No tiles Tiles Diff. No tiles Tiles Diff. No tiles Tiles Diff. 

Loam 23.38 23.38 0.00 0.24 0.24 0.00 -6.40E-07 -6.40E-07 0.00 0.00 0.00 0.00 29.47 29.47 0.00 

Sandy 
Loam  

20.19 20.19 0.00 0.18 0.18 0.00 -1.40E-08 -1.40E-08 0.00 0.00 0.00 0.00 32.82 32.82 0.00 

Silty  
Loam 1 

19.63 19.63 0.00 0.28 0.28 0.00 0.00 0.00 0.00 232.04 198.93 33.11 -198.85 -165.74 -33.11 

Silty 
Loam 2 

19.62 19.76 -0.15 0.28 0.29 0.00 0.00 0.00 0.00 132.75 202.63 -69.88 -99.53 -169.55 70.03 

Silty 
Loam 3 

17.66 17.67 -0.01 0.26 0.26 0.00 -35.02 -34.52 -0.50 0.00 0.08 -0.08 0.15 0.57 -0.42 
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Table 11. Distribution of landform types in Ebey’s Landing National Historical Reserve.  

Unit Type Unit ID Area (km
2
) Area (%) 

Glaciated Uplands ---- 26.25 36.10 

                Glaciated Uplands GU             21.68            29.82 

                Glaciated Uplands -Strandlines SL           4.57           6.28 

Ice-marginal Delta  ---- 23.69 32.57 

                Ice-marginal Delta -Top ID-T            18.68            25.69 

                Ice-marginal Delta - Front ID-F           3.02           4.15 

                Ice-marginal Delta - ice contact slope ID-CS           1.99            2.73 

Marine Terrace MT 6.30 8.66 

Kettle Kame KK 5.98 8.22 

Lagoon LG 2.09 2.88 

Dunes DS 1.87 2.57 

Bog BG 1.28 1.77 

Bluff BF 1.17 1.61 

Barrier BR 1.13 1.56 

Beach BH 0.72 0.99 

Ravine RV 0.67 0.93 

Modified Land MD 0.64 0.89 

Pleistocene Moraine PM 0.38 0.52 

Alluvial Fan AF 0.33 0.46 

Tombolo TB 0.13 0.18 

Marsh MA 0.05 0.07 

Lake LK 0.02 0.03 

Total  72.71 100 
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Table 12. Correlation of unknown tephra collected near Lake Pondilla with known tephra. Tephra was located in the 
LPB-09-02 core, push 4 between 81-82cm and 781-782 cm below the surface.  

 

Na2O MgO Al2O3 SiO2 Cl* K2O Fe2O3** 

1 3.76 0.74 14.27 73.91 0.76 3.46 3.27 

2 4.10 0.58 14.14 74.89 0.42 3.25 2.80 

3 4.27 ---- 14.18 75.82 1.65 3.71 ---- 

4 4.13 ---- 14.78 77.41 0.30 3.31 ---- 

5 3.69 ---- 14.66 77.78 0.29 3.51 ---- 

6 4.07 ---- 14.75 77.37 0.38 3.35 ---- 

7 3.96 ---- 14.51 77.78 0.25 3.44 ---- 

8 4.25 ---- 14.64 77.02 0.52 3.44 ---- 

Average (SD) 4.03 (0.20) 0.66 (0.08) 14.49 (0.24) 76.50 (1.36) 0.57 (0.43) 3.43 (0.13) 3.03 (0.23) 

Mazama 

Reference*** 
4.47 0.47 14.38 72.99 0.18 2.72 2.48 

*Cl values converted from Cl2O values using a correction factor of 1.111348 

**Fe2O3 values calculated from FeO values using a correction factor of 0.814630303 

***Mazama is reference tephra #30 in the tephra identification database, GeoAnalytical Laboratory, Wa 
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Figure 1. Location of Ebey’s Landing National Historical Reserve (NHR), Ebey’s Prairie and other locations noted 

in text. 
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Figure 2. LiDAR image of Ebey’s Landing NHR with surficial landforms (adapted from Polenz et al., 2005; 

Kovanen and Slaymaker, 2004). Black arrows indicate flow in paleo-channels. 
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Figure 3. Well log stratigraphy for selected wells in and near Ebey’s Prairie Watershed. Elevations are referenced to modern sea level and are in meters.
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Figure 4. The extent of the Puget Lobe and the Juan de Fuca Lobe at glacial maximum (source: Porter and 
Swanson, 1998). 
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Figure 5. Locations of local weather stations and stream gauging station used for DHSVM model simulations. 
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Figure 6. Soil types in the Ebey’s Prairie watershed (outlined in white), from the 1958 US Department of 
Agriculture soil survey. Delineation of watershed boundaries were determined, as part of the hydrologic modeling 
procedures, using ESRI ArcGIS software. Only soils located within the watershed are labeled. 
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Figure 7. Locations of present day surface water in Ebey’s Prairie, which includes a small marsh remnant and a 
seasonal creek. The location of three wells (wells: DFT, BFE, 363) in the prairie used for measuring seasonal 
changes in groundwater heights. 
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Figure 8. Schematic of DHSVM model. Using digital elevation model (DEM) topographic data, the modeled 
landscape is divided into computational grid cells with vegetation and soil properties assigned to each cell. For each 
time step the model provides energy and water budget solutions. Individual cells are hydrologically linked through 
surface and subsurface routing.  

 
Figure 9. DHSVM topographic input grid representing Ebey's Prairie with no drainage tiles. The high resolution 
LiDAR data was resampled to a courser 10 m X 10 m resolution to increase processing speeds. Watershed 
boundaries were generated for a user-defined drainage point using the ‘Hydrology Modeling’ tool in ArcGIS. 
Ebey’s Prairie watershed includes parts of both Ebey’s and Smith prairies. 
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Figure 10. LiDAR derived DEM representing Ebey's Prairie watershed with drainage tiles. The subsurface network 
of drainage tiles was simulated by “burning” them into the DEM, thereby forcing proper flow routing. 

 
Figure 11. DHSVM stream network representing basin flow without drainage tiles. An AML script from the 
University of Washington was used to create the network based on the DEM representing Ebey’s Prairie watershed 
without drainage tiles. 
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Figure 12. Stream network representing basin flow with drainage tiles present. An AML script from the University 
of Washington was used to create the network based on the DEM representing Ebey’s Prairie watershed with 
drainage tiles. 

 
Figure 13. Soil texture grid used by DHSVM representing Ebey's Prairie watershed. Soil texture was generated 
from the 1958 USDA Island County Soil Survey and resampled to a 10 m X 10 m resolution.  
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Figure 14. DHSVM soil depth input grid representing Ebey’s Prairie with drainage tiles. AMLs provided by 
University of Washington were used to calculate soil thickness based on degree of slope and flow accumulation. 

 
Figure 15. DHSVM landcover input grid representing Ebey's Prairie watershed. A landcover grid of dominate 
overstory vegetation type was created from 30 m resolution Landsat Thematic Mapper and Landsat Enhanced 
Thematic Mapper satellite imagery from 2001. The landcover grid was resampled to a 10 m X 10 m resolution.  
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Figure 16. DHSVM Road network input grid. Data provided by Washington State Department of Transportation. 
AML scripts provided by University of Washington were used to create road crossing features (culverts), identify 
basin edges, and populate road input files. 

 

Figure 17. Rating curve created from the Ebey’s Prairie stream and sixteen discharge measurements collected 
between January 18, 2009 and May 7, 2010. Discharge was measured by timing the fill rate of a five gallon bucket. 
Stage values were measured using a Global Water WL15 pressure transducer. Units for discharge is cubic feet per 
second (cfs) and for stage is feet (ft). 
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Figure 18. Comparison of Ebey’s Prarie stream hydrograph with NWS Coupeville 1S COOP hyetograph for the period of November 2, 2008 17:00 to August 
29, 2009 18:00 and from October 6, 2009 14:00 to May 7, 2010 17:00. The period of missing data was a result of a dead battery in the pressure transducer.  
Discharge was calculated by applying a rating curve to  15-minute stage data from a pressure tranducer installed by the author. Six discharge events contained 
extreme flows that could not be attributed to any precipiitation event and were classified as suspect and removed. However, data presented in this hydrograph is 
raw data, containing the suspect data.The suspect discharge events occurred between July 27,2009 10:00 and December 11, 2009 14:00 for a total of 187 hours.  
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Figure 19 a-e. DHSVM meteorological inputs. Data source is Washington State University (WSU) Mt. Vernon 
weather station for WY01-WY06 and WSU Whidbey weather station for WY07-WY10. Quality control was 
conducted by the author. Missing or suspect values were replaced with data from the City of Bellingham 
Northshore, National Weather Service (NWS) Coupeville 1S COOP and Whidbey Naval Air Station (NAS) weather 
stations.
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Figure 20. Observed and predicted discharge for the Ebey’s Prairie stream for the DHSVM calibration period of November 2, 2008 to September 30, 2009.    

 

Figure 21. Observed and predicted discharge for the Ebey’s Prairie stream for the DHSVM validation period of October 1, 2009 to May 7, 2010.   
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Figure 22 a-d. Hydrograph comparing predicted stream discharge for the Ebey’s Prairie Watershed with drainage 
tiles and without drainages tiles for water years 2001 (a), 2002 (b), 2003 (c), and 2004 (d). 
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Figure 23 a-d. Hydrograph comparing predicted stream discharge for the Ebey’s Prairie Watershed with drainage 
tiles and without drainages tiles for water years 2005(a), 2006 (b), 2007 (c), and 2008 (d). 

0

20

40

60

80

100

120
D

is
ch

ar
ge

 (
m

3 /
h

r)
 

Water Year 2005 
Drainage Tiles
No Drainage Tiles

0

20

40

60

80

100

D
is

ch
ar

ge
 (

m
3
/h

r)
 Water Year 2006 

Drainage Tiles
No Drainage Tiles

0

20

40

60

80

100

120

D
is

ch
ar

ge
 (

m
3 /

h
r)

 

Water Year 2007 
Drainage Tiles
No Drainage Tiles

0

20

40

60

80

100

D
is

ch
ar

ge
 (

m
3 /

h
r)

 Water Year 2008 
Drainage Tiles
No Drainage Tiles



 

106 
 

 

 

Figure 24 a-b. Hydrograph comparing predicted stream discharge for the Ebey’s Prairie Watershed with drainage 
tiles and without drainages tiles for water years 2009 (a) and 2010 (b). 
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Figure 25. Comparison of hydrographs for Ebey’s Prairie watershed with drainage tiles and without drainage tiles, 
along with a hyetograph for NWS Coupeville 1S COOP station, for the period of November 15, 2009 to December 
15, 2009. 
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Figure 26. Pixel dump locations used for analyzing hydrologic response of individual soils to drainage tiles. Pixel 
dump is a term used in DHSVM modeling where model outputs are provided for an individual pixel. The pixel 
locations are provided in reference to soil class, location of the drainage tile network and topographic depressions or 
closed basins observed in LiDAR imagery.  
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Figure 27. Geomorphic map for Ebey’s Landing National Historical Reserve (NHR). 
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Figure 28. Location of closed basins, drainage tile network and respective USDA soil types. Insets are smaller scale 
images of closed basins with alphabetic identifiers. LiDAR analysis revealed two closed basins (A & C) located near 
the existing marsh (B) in Ebey’s Prairie. 
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Figure 29. Location of coring sites LP-08-01 and LPB-09-01/LPB-09-02 at Lake Pondilla, a kettle pond in Ebey’s 
Landing NHR. 

 

Figure 30. Digital imagery of LP-08-01 medium to very thick bedded organic mud unit (entire push length in 
image). The unit extends from 0-346 cm. 
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Figure 31. Digital imagery of LP-08-01 thin to medium bedded poorly decomposed peat unit (entire length of push 
in image). Unit is located at 347-365 cm, 375-383 cm, 567-580 cm and 598-664 cm. 

 

Figure 32. Digital imagery of LP-08-01 very thin bedded fine sand (red arrows) from 597-598 cm. 
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Figure 33. Fine sand found in LP-08-01 core at a depth of 597-598 cm.  The field of view in the image is 3x4 mm. 

 

Figure 34. Digital imagery of LPB-09-01 of mostly very thick bedded peat and mud strata (entire push length in 
image). The unit extends through the entire core. 
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Figure 35. Digital imagery of LPB-09-01 thin to medium bedded lighter colored peat and organic mud strata, (red 
arrows) from 267-274 cm. A scond strata also exists at 294-305 cm. 

 

Figure 36. Digital imagery of LPB-09-02 very thin bedded tephra startum, (red arrows) from 781-782 cm. 
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Figure 37. Magnetic susceptibility (MS) and Loss on Ignition (LOI) data for Lake Pondilla core LP-08-01. 

 

 

Figure 38. Magnetic susceptibility (MS) and Loss on Ignition (LOI) data for Lake Pondilla core LPB-09-01/02.  
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Figure 39. Image of tephra collected from core LPB-09-01/02, using a scanning electron microscope. 

 

  



 

117 
 

APPENDIX A. DHSVM Basin Setup 

 
1. CREATE A DEM GRID 
 
1. Create a workspace. I created a folder on the C drive called MFdhsvm and created a 
folder within MFdhsvm for dems. (C:/MFdhsvm/dems) 
 
2. Download and unzip Digital Elevation Models (DEMs). 
I used the following DEMs in Washington State: Deming, Canyon Lake, Goat Mountain, 
Mt. Baker, Acme, Cavanaugh Creek, Twin Sisters, and Baker Pass. 
I downloaded them from: 
http://duff.geology.washington.edu/data/raster/tenmeter/ 
 
3. Convert DEM files to raster files 
Open ArcMap→Arc Toolbox→Conversion Tools→To Raster→DEM to Raster 
Input USGS DEM file: deming.dem 
Output raster: C:/MFdhsvm/dems/deming 
→OK 
This will convert the DEM to a raster, and import the raster to ArcMap. 
All DEMs have to be converted to raster files individually. 
 
4. Mosaic DEMS 
a. Set analysis environment 
From Spatial Analyst dropdown menu→Options 
Under general tab, Working directory: C:/MFdhsvm/dems. 
Under Extent tab, Analysis extent: Union of Inputs 
Under Cell size tab, Analysis cell size: Maximum of Inputs 
→OK 
b. Mosaic the DEMs using Raster Calculator 
Open Spatial Analyst toolbar → raster calculator 
Create the Mosaic expression in the text box: 
<Nooksackdem>=mosaic ([deming], [CanyonLake], [etc.]) 
→Evaluate 
c. Once DEMs are mosaicked, locate the new DEM in ArcCatalog and drag it into 
ArcMap. 
 
5. Resample DEMs to 50 m by 50 m pixel resolution. 
a. Set analysis environment (very important) 
Open ArcToolbox→Data Management tools→Raster→Resample→environment 
Under General Settings tab: 
Present Workspace: (C:/MFdhsvm/dems) 
Scratch Workspace (C:/MFdhsvm/dems) 
Output coordinate system: Same as layer “Nooksackdem” 
Output Extent: Same as layer “Nooksackdem” 
Under Raster Analysis settings tab: 
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Cell size: 50 
Mask: None 
→OK 
b. Resample: 
Input Raster: “Nooksackdem” 
Output Raster: “dem50” 
Cell size: 50 
Resampling Technique: Nearest 
→OK 
Once the mosaicked raster is resampled to 50m resolution, Nooksackdem (10 m resolution) 
can be removed from ArcMap. 
 
2. CREATE A WATERSHED MASK 
 
1. Create another folder within the MFdhsvm folder. I titled mine “setup”. 
 
2. Fill sinks to even out the dem 
Open hydrology/models toolbar→Fill Sinks 
Input surface: dem50 
Fill limit: <Fill_All> 
Output raster: C:/MFdhsvm/setup/filldem 
→OK 
 
3. Perform flow direction on the filled DEM. This grid is necessary for determining the 
watershed boundary. 
Open hydrology/models toolbar→Flow direction 
Input surface: filldem 
Output raster: C:/MFdhsvm/setup/flowdir 
→OK 
 
4. Perform flow accumulation. This grid is also necessary for determining the watershed 
boundary. 
Open hydrology/models toolbar→Flow accumulation 
Direction raster: flowdir 
Output raster: C:/MFdhsvm/setup/flowacc 
→OK 
 
5. Set interactive properties to create a watershed boundary 
Open hydrology/models toolbar→Interactive properties 
Flow direction: flowdir 
Flow accumulation: flowacc 
→OK 
 
6. Create the watershed boundary 
Click the watershed button from the hydrology/models toolbar. 
This is an interactive tool which will determine the boundary of the watershed based on the 
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destination cell. I selected the point at which the Middle Fork converges with the main 
channel of the Nooksack River and ArcGIS determined which cells would eventually drain 
water to that point. I had to repeat the process a number of times before I was satisfied with 
the watershed boundary. 
When a watershed is created, it may be a temporary file. To make it permanent, right-click 
on the watershed grid in ArcMap table of contents→Make Permanent→set source to the 
present workspace (C:/MFdhsvm/setup/watershed). 
 
7. Create a watershed polygon 
I created a watershed polygon that is used to clip the grids that are necessary input for 
DHSVM. 
Open ArcToolbox→Conversion Tools→From Raster→Raster to Polygon 
Input raster: C:/MFdhsvm/setup/watershed 
Output polygon features: C:/MFdhsvm/setup/watershedpoly 
→OK 
 
8. Once the watershed polygon is created, it can be used to clip the DEM and hillshade 
(optional) to the watershed. 
Set working environment: 
Click Spatial Analysts toolbar→ Options 
Working directory: C:/MFdhsvm/setup 
Analysis mask: watershedpoly 
Extent: watershedpoly 
Cellsize: 50 
From Spatial Analyst dropdown menu→raster calculator 
Type the expression: sheddem=nooksackdem 
→Evaluate 
 
3. CREATE A LANDCOVER GRID 
 
1. Download 2001 landcover grid from NOAA from 
http://www.csc.noaa.gov/crs/lca/pacificcoast.html. 
I downloaded the coverage for the entire west coast. 
The landcover file is already an ESRI grid, so it does not need to be converted. The PCS 
may be different than that for the DEM, but ArcGIS should be able to project the grid on the 
fly. 
2. Resample grid to 50 by 50 m resolution. 
Open ArcToolbox→Data management Tools→Raster→Resample 
Set the analysis environment (very important): 
Under General Settings tab: 
Present Workspace: (C:/MFdhsvm/setup) 
Scratch Workspace (C:/MFdhsvm/setup) 
Output coordinate system: Same as layer “Nooksackdem” 
Output Extent: Same as layer “Nooksackdem” 
Under Raster Analysis settings tab: 
Cell size: 50 
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Mask: None 
→OK to close environments setting 
Input raster: landcover 
Output raster: landcover50 
Output cell size: 50 
Resampling technique: nearest neighbor 
→OK 
 
3. Clip landcover grid to watershed boundary. 
Set analysis environment: 
Click Spatial Analysts toolbar→ Options 
Working directory: C:/MFdhsvm/setup 
Analysis mask: watershedpoly 
Extent: watershedpoly 
Cellsize: 50 
From Spatial Analyst dropdown menu→raster calculator 
Type the expression: shedcover=landcover50 
→Evaluate 
 
4. Reclassify NOAA vegetation classifications to DHSVM classifications 
Open ArcToolbox→Spatial Analyst→Reclass→Reclassify 
Set general and raster analysis environments 
Input Raster: landshed 
Output Raster: reclassveg 
Reclass Field: Value 
Then: 
 
 
NOAA NOAA DHSVM  
2 High Intensity Developed  13 Urban 

3 Low Intensity Developed  13 Urban 

5 Grassland  10 Grassland 

6 Deciduous Forest 4 Deciduous Broadleaf 

7 Evergreen Forest 15 Coastal Conifer 
8 Mixed Forest  5 Mixed Forest 

9 Scrub/Shrub  8 Closed Shrub 

10 Palustrine Forested Wetland  4 Deciduous Broadleaf 
11 Palustrine Scrub/Shrub Wetland 8 Closed Shrub 
12 Palustrine Emergent Wetland 10 Grassland 
16 Unconsolidated Shore 12 Bare 
17 Bare land 12 Bare 
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18 Water 14 Water 
19 Palustrine Aquatic Bed 14 Water 
22 Ice 20 Ice 
 
4. CREATE VARIABLE GLACIER GRIDS 
 
1. Map out glacial moraines. I used a stereo pair of aerial photos to map moraines. 
 
2. Determine retreat rate of glacier(s) (see section 4.1.3). 
 
3. Download digital aerial photos and bring them into ArcMap. I downloaded photos 
from http://gis.ess.washington.edu/data/raster/doqs.html, and merged them using the 
‘mosaic’ command in Raster Calculator (see ‘mosaic DEMs’). 
4. Create a new feature in ArcCatalog 
Open ArcCatalog →Open your workspace (I created a new workspace called ‘glacier 
coverages’ in the ‘setup’ folder →click new→shapefile→Name: glacier2050, Feature Type: 
polygon. 
Drag the new shapefile into ArcMap table of contents along with the aerial photos and 
present vegetation layer. 
 
5. Edit the new shapefile 
In ArcMap click Editor→start editing→select glacier2050→Task: create new feature, 
Target: glacier2050. 
Click on the pencil; begin digitizing the past or future glacier coverages by creating 
polygons that will be merged with the present vegetation grid. I used the measuring tool, the 
present vegetation grid, and the air photos to aid in digitizing.When creating smaller 
glaciers, the polygons will be reclassified to ‘Bare’ soil type and then merged with the 
vegetation grid. 
 
6. Convert the shape file to a raster (see ‘convert soil polygon to raster’ below) 
 
7. Reclassify the new raster to vegetation type 12 (bare) or type 20 (Ice) (See 
‘Reclassify NOAA vegetation classifications to DHSVM classifications’ above). 
 
8. Merge the reclassified raster with the original landcover grid. 
In the Spatial Analyst drop down menu, set options. 
Open Raster Calculator→Type: Glacier2050 = merge ({reclassified raster},{veg grid}) 
→Evaluate 
Glacier2050 is now the new vegetation grid representing smaller glaciers. 
 
5. CREATE A SOIL TEXTURE GRID 
 
1. Download soil texture coverage from STATSGO for Whatcom County, WA from 
http://www.essc.psu.edu/soil_info/etc/statsgolist.cgi?statename=Washington 
I created a new folder within C:/MFdhsvm called soils. Save the file (wa.e00) in this file. 
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2. Convert file. This is a GIS export file that has to be converted in ArcCatalog. 
Open ArcCatolog→Conversion Tools→Import from Interchange File 
Input file: C:\MFdhsvm\soil\wa.e00\wa.e00 
Output dataset: C:\MFdhsvm\soil\wa 
The file will now appear in ArcCatolog and can be dragged into ArcMap. 
The PCS may be different than that for the DEM, but ArcGIS should be able to project the 
grid on the fly. 
 
3. Convert soil polygon to raster. 
Open ArcToolbox→Conversion Tools→To Raster→Feature to Raster 
Set analysis environments by clicking on the Environments button 
Under General Settings tab: 
Present Workspace: (C:/MFdhsvm/soils) 
Scratch Workspace (C:/MFdhsvm/soils) 
Output coordinate system: Same as layer “Nooksackdem” 
Output Extent: Same as layer “Nooksackdem” 
Under Raster Analysis settings tab: 
Cell size: 50 
Mask: None 
OK to close environments setting 
Input features: wa polygon 
Field: MUID 
Output raster: C:\MFdhsvm\soil\wa.e00\wa\soilgrid 
Output cell size: 50 
→OK 
Remove wa polygon from ArcMap 
 
4. Clip soil grid to watershed 
Set analysis environment: 
Click Spatial Analysts toolbar→ Options 
Working directory: C:/MFdhsvm/soils 
Analysis mask: watershedpoly 
Extent: watershedpoly 
Cellsize: 50 
From Spatial Analyst dropdown menu→raster calculator 
Type the expression: soilshed=soilgrid 
→Evaluate 
 
Soil classifications are as follows: 
MUID Description MUID Description 
1 Sand 10 Sandy Clay 
2 Loamy Sand 11 Silty Clay 
3  Sandy Loam 12 Clay 
4 Silty Loam 13 Organic (as loam) 
5 Silt 14 Water (as clay) 
6 Loam 15 Bedrock 
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7 Sandy Clay Loam  16 Other (as SCL) 
8 Silty Clay Loam  17 Muck 
9 Clay Loam  18 Talus 
 
6. CREATE SOIL DEPTH AND STREAM NETWORK GRIDS 
I created the soil depth and stream network grids using Arc in the spatial analysis lab (AH 
16) using the following methods: 
 
1. Create a workspace 
Create a new folder: C:/TEMP/soild 
Copy the watershed grid (watershed), the clipped dem (sheddem) and amlscripts from the 
DHSVM tutorial into the “soild” folder. 
Check the computer to ensure that it has a Java Runtime Environment (JRE). If it doesn’t, 
download Java software from www.sun.com. 
To check for JRE, open Arc and type: 
Arc: &sys java –version 
If the JRE is installed, you should get: 
Java version “1.4.2_04” 
Java [TM] 2 Runtime Environment, Standard Edition (build 1.4.2_04-b04) 
Java HotSpot[TM] Client VM (build 1.4.2_04-b04, mixed mode). 
The watershed mask values must be defined as inbasin=1 and outside basin=NODATA. 
Otherwise the AML will create a stream network for the entire raster. You can check the 
values in ArcMap by opening the DEM properties dialogue. 
***Before running the AML, make sure to change the path to AddAat2.class from with the 
createstreamnetwork AML. If this step is skipped, the AML will encounter an error, but 
will continue to run anyway. It will produce zeros within the streamnetwork.dat for slope, 
segorder, etc. and DHSVM cannot use this file.*** 
96 
I simply opened the AML, used the ‘find’ tool to locate the path and changed the path to: 
&sys java -classpath ../soild/amlscripts/ AddAat2 %streamnet% 
 
2. Run the AML 
Open ARC. 
Type: 
ARC: &workspace C:/TEMP/soild 
ARC: &watch aml.watch 
ARC: &amlpath C:/TEMP/soild/amlscripts 
ARC: &run createstreamnetwork sheddem watershed mf_soild mf_streams MASK 220000 
0.76 1.5 
The last three numbers are variables representing the minimum contributing area before a 
channel begins, the minimum soil depth, and maximum soil depth (in meters). 
 
7. CREATE A SERIES OF SHADING MAPS 
 
1. Create a workspace 
Create a new folder: C:/TEMP/shadow 
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Copy the clipped dem (sheddem) into this folder using ArcCatalog. The solar AML 
(process_solar1 is not available in the amlscripts folder in the DHSVM tutorial, but can be 
found in the amlscripts folder on the attached cd). This file should also be copied into the 
shadow folder. Process_solar.aml requires 3 “C” files to run. I compiled these using the 
‘lcc’ compiler in the Computer Science department with the help of Matt Paskus. The 
compiled files which are make_dhsvm_shade_maps.exe, skyview.exe, and 
average_shadow.exe, can also be found on the attached cd. Copy these files into the 
‘shadow’ file. 
 
2. Run the AML 
Type: 
Arc: &workspace C:/TEMP/shadow 
Arc: &watch aml.watch 
Arc: &amlpath C:/TEMP/shadow/amlscripts 
Arc: &r process_solar1 middlefork sheddem 1 0.0 
Arc: quit 
The basin name is “middlefork” and the elevation grid is “sheddem”. The last two numbers 
represent the model timestep and GMT offset, respectively. 
The AML command “rm” is not recognized in Windows. I transferred the shadow maps to 
Horton anyway, and renamed each file (ex: ‘Shadow.01.hourly.bin’ is renamed 
‘shadow.01.bin’). 
 
8. EXPORT DEM, SOIL TYPE, SOIL THICKNESS, VEGETATION, AND 
WATERSHED FILES AS ASCII GRIDS 
I created a new file for each conversion and copied the GIS grid to be converted into the 
file. 
I then convert all the NoData values in the grids to something that DHSVM recognizes (e.g., 
water=14) and converted the grids to ascii format. 
Example: 
For the watershed grid, Type: 
Arc: &workspace C:TEMP/watershed (with “watershed” grid) 
Arc: grid 
GRID: watershed.asc = gridascii(con(isnull(watershed),14,watershed)) 
GRID: q 
 
9. CONVERT ASCII GRIDS TO BINARY 
I converted the ascii gids (soilclass.asc, vegclass.asc, and mask.asc) to binary files on 
Horton using “myconvert” in the input file. 
**The correct variable type for each grid is as follows:** 
Mask, landcover, soil type: unsigned character or “uchar” 
Dem, soildepth: float 
Example (for mask, landcover, soil type): 
horton > ./myconvert ascii uchar mask.asc mask.bin 375 496 
Example (for dem, soildepth): 
horton > ./myconvert ascii float DEM.asc DEM.bin 375 496 
Where: 
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horton> ./myconvert source_format target_format source_file target_file number_of_rows 
number_of_columns 
 
10. CREATE A FINAL STREAM MAP AND STREAM NETWORK FILE 
I created these files on Horton using “assign”. The files stream.network.dat and 
stream.map.dat were created during step #5 (stream network grid). mf.stream-net.dat and 
mf.stream-map.dat are the final map and network files. 
Example: 
horton>./assign stream.network.dat stream.map.dat mf.stream-net.dat mf.stream-map.dat 
 
11. LOCATE THE STREAM GAUGE FOR DHSVM CALIBRATION. 
The stream gage location in DHSVM is based on the location of the end of a stream segment 
generated in the stream network aml, not the actual location of the gage. Open ArcMap. 
Drag into a new, empty map: sheddem and the streams arc. Locate the position of the 
stream gauge using the coordinate indicators in the lower right corner of the screen, or plot 
the location of the stream gauge using “Tools” and “add X Y data”. The output segment is 
the segment that terminates the closest to the stream gauge location. Stream discharge is not 
at a pixel, it is at the end of a selected stream segment. After the stream gauge is located, 
click on the stream segment nearest the gauge to determine the stream segment ID #. 
Record the segment number/value. In the stream network file, type ‘SAVE’ next to the 
appropriate stream segment. 
 
12. SET INITIAL CONDITIONS FOR DHSVM CALIBRATION 
 
1. Create initial channel state files: 
Unix: % awk’ {print $1, 0.1} mf.stream_net.dat> channel.state.9.30.2003.00.00 
 
2. Create model state files 
I used initialstate.txt that is found in the dshvm tutorial and changed the path, date, and # of 
rows and columns. 
Then: 
Horton: MakeModelStateBin InitialState.txt 
This creates the initial Interception, Snow, and Soil state files for the date that is specified in 
the initialstate.txt file. The date indicates the beginning of the model simulation. 
 
13. RUN THE MODEL 
From the mfork directory (horton/carrie/dhsvm/mfork>) 
horton> DHSVM input.mfork 
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APPENDIX B. Glossary of Geomorphologic Terms 

Alluvial Fan: A low, outspread mass of loose materials and/or rock material, commonly with 
gentle slopes, shaped like an open fan or a segment of a cone, deposited by a stream (best 
expressed in semiarid regions) at the place where it issues from a narrow mountain or upland 
valley; or where a tributary stream is near or at its junction with the main stream. It is steepest 
near its apex which points upstream and slopes gently and convexly outward (downstream) with 
a gradual decrease in gradient. 

Barrier: An elongate accumulation of sand and/or gravel formed by waves, tides and wind, 
parallel to shoreline, rising above present sea-level, often impounding terrestrial drainage 
blocking of a lagoon. For this mapping project, barriers include spits, bar, cuspate forelands, 
looped bar and barrier islands. Source: Woodroffe, 2002. 

Beach: (a) A gently sloping zone of unconsolidated material, typically with a slightly concave 
profile, extending landward from the low-water line to the place where there is a definite change 
in material or physiographic form (such as a cliff) or to the line of permanent vegetation (usually 
the effective limit of the highest storm waves); a shore of a body of water, formed and washed by 
waves or tides, usually covered by sand or gravel; (b) the relatively thick and temporary 
accumulation of loose water-borne material (usually well-sorted sand and pebbles) accompanied 
by mud, cobbles, boulders, and smoothed rock and shell fragments, that is in active transit along, 
or deposited on, the shore zone between the limits of low water and high water. Source: USDA 
Geomorphology Glossary 
 
Bluff : A high bank or bold headland, with a broad, precipitous, sometimes rounded cliff face 
overlooking a plain or body of water, especially on the outside of a stream meander; ex. a river 
bluff. Source: USDA Geomorphology Glossary 
 
Bog: Waterlogged, spongy ground, consisting primarily of mosses, containing acidic, decaying 
vegetation such as sphagnum, sedges, and heaths that may develop into peat. Compare - fen, 
marsh, swamp. Source: USDA Geomorphology Glossary 
 
Dunes: A low mound, ridge, bank or hill of loose, windblown, subaerially deposited granular 
material (generally sand), either barren and capable of movement from place to place, or covered 
and stabilized with vegetation, but retaining its characteristic shape. (See barchan dune, parabolic 
dune, parna dune, shrubcoppice dune, seif dune, transverse dune). Source: USDA 
Geomorphology Glossary 
 
Glaciated Uplands: An upland with glacial origins. Upland is an informal, general term for (a) 
the higher ground of a region, in contrast with alow-lying, adjacent land such as a valley or plain. 
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(b) Land at a higher elevation than the flood plain or low stream terrace; land above the footslope 
zone of the hillslope continuum. Source: USDA Geomorphology Glossary 
 
Glaciated Uplands- Strandlines: Strandlines occurring on glaciated uplands on glaciated 
uplands. Strandlines are steplike terrace or terraces superimposed on a rising coastline during 
continental uplift, isostasy or eustatic sea level change representing shorelines formed from 
glacio-eustatic sea level highstands. Source: USDA Geomorphology Glossary. 

Ice Marginal Delta – Ice contact slopes: Ice contact slope associated with an ice marginal 
delta. Ice contact slopes are steep escarpment of predominantly glaciofluvial sediment that was 
deposited against a wall of glacier ice, marking the position of a relatively static ice-margin; an 
irregular scarp against which glacier ice once rested.  Source: USDA Geomorphology Glossary. 

Ice Marginal Delta – Forset beds: Foreset beds associated with an ice marginal delta. Foreset 
beds are pro-glacial outwash deposited in low energy marine waters creating a fan shape with a 
flat top surface and steeper front surface. The delta slope is characterized by a sharp change in 
slope at the leading edge of the delta; it is located continuously below sea level and 
characteristics defined by marine processes. It may contain strandlines from a relatively lowering 
sea. Steep slope on side that is in contact with ice (ice-contact slope). Source: USDA 
Geomorphology Glossary 

Ice Marginal Delta – Topset beds: Topset beds associated with an ice marginal delta. Topset 
beds are pro-glacial outwash deposited in low energy marine waters creating a fan shape with a 
flat top surface and steeper front surface. The delta plain is the nearly flat surface located mostly 
above tidal influence. It is driven mostly by fluvial processes and may include delta distributary 
channels. Steep slope on side that is in contact with ice (ice-contact slope). Source: USDA 
Geomorphology Glossary. 

Kame-Kettle Topography: A surface with many kettles separated with short irregular ridges, 
knobs and hummocks composed of stratified sand and gravel deposited by a glacial meltwater. 
Formed by the melting of a large, detached blocks of stagnant ice that had been buried in the 
drift.  Kettles range in depth from 1 to tens of meters, and can contain lakes, swamps or peat 
bogs. Source: USDA Geomorphology Glossary.   

Lagoon: [coast] A shallow stretch of salt or brackish water, partly or completely separated from 
a sea or lake by an offshore reef, barrier island, sandbank or spit. Source: USDA Geomorphology 
Glossary 
 
Lake: An inland body of permanently standing water fresh or saline, occupying a depression on 
the Earth’s surface, generally of appreciable size (larger than a pond) and too deep to permit 
vegetation (excluding subaqueous vegetation) to take root completely across the expanse of 
water. Source: USDA Geomorphology Glossary 
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Marsh: Periodically wet or continually flooded areas with the surface not deeply submerged. 
Covered dominantly with sedges, cattails, rushes, or other hydrophytic plants. Compare - salt 
marsh, swamp, bog, fen. Source: USDA Geomorphology Glossary 
 
Marine Terrace: A constructional coastal strip, sloping gently seaward, veneered by marine 
deposits (typically silt, sand, fine gravel). Compare - terrace, wave-built terrace. Source: USDA 
Geomorphology Glossary 
 
Mass movement – Slump: Type of landslide involving rotational slide and/or failure of 
saturated ground material. Slump and creep landforms are lumped together into one category. 
Slumps are found on over steepened slopes in the Debris Apron zone, along glacial moraines, 
and river cut banks. Creeps are located at high elevations in the subalpine where snow cover 
persists into the spring and in the Debris Apron on steep saturated slopes. Associated landforms 
and features include Pleistocene moraines, cut banks, debris cones, springs, seeps. Slumps occur 
by a rotational slip of cohesive sediments and are usually triggered by undercutting of steep 
slopes along river banks. Creeps are a slow movement induced by saturated ground. Slumps are 
typically small and if found adjacent to the river, supply sediment and wood to streams. Surficial 
material is Soil, colluvium, till. Slumps are difficult to distinguish on topographic maps.  Air 
photos may show an area with “brighter” deciduous vegetation, compared to adjacent landforms, 
and fresh new soil indicating disturbance. Creeps are rare or at least are observed less and are 
noted in field book with associated description. Stripes or patterned ground at high elevation is 
evidence for freeze/thaw action classified as pattern ground and not creep. Slumps (when small, 
and next to stream) can be mapped as a small half circle, almost a dot. Jack-straw trees (straight 
trunks falling–in) may be present on slumps.  Creeps may contain pistol gripped (curved trunks 
down slope) trees. Potential Vegetation is typically lowland; depends on the rate, age, and 
location of disturbance. Source: NPS and USDA Geomorphology Glossary 

Modified: (anthropogenic feature) - An artificial feature on the earth’s surface (including those 
in shallow water), having a characteristic shape and range in composition, composed of 
unconsolidated earthy, organic materials, artificial materials, or rock, that is the direct result of 
human manipulation or activities; can be either constructional (e.g., artificial levee) or 
destructional (quarry).  Source: USDA Geomorphology Glossary 

Pleistocene Moraine: Ridge composed of till that has been deposited by a glacier. PM are large 
linear features usually > 10 m tall with surfaces commonly having hummocky topography with 
scattered large sub-rounded boulders. Usually located below tree line along valley walls and 
valley floor in the debris apron zone.  PMs are sometimes preserved/found on the uphill side of 
major stream junctions. Associated landforms and features include hummocky, sharp crested 
(ridge descends form cirque), kame terrace, end, medial, and lateral moraine. Formed during  
glacial advance and retreat (kame terraces glaciofluvial glaciolacustrine). Landform age ranges 
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between ~15,000- 10,000 years. Surficial material is till. Source: NPS and USDA 
Geomorphology Glossary 

Ravine: A small stream channel; narrow, steep-sided, commonly V-shaped in cross section and 
larger than a gully, cut in unconsolidated materials. General synonym (not preferred) - gulch. 
Compare – arroyo, draw,gully. Source: USDA Geomorphology Glossary 
 
Tombolo: A sand or gravel bar or barrier that connects an island with the mainland or with 
another island. Source: USDA Geomorphology Glossary 
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